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HP OpenView Service Desk 
for the Windows and UNIX operating systems 

Release Notes 
Software version: 5.10 Patch 16 / June 2011 

Edition 1 
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In This Version 

This release contains improvements that have been implemented since Service Desk 5.0, including the 
following: 

Addition of the HP OpenView web console. 

Ability to log approval votes in history lines. 

List of approvers maintained during the life of an object. 

Blocking of services, service levels, and service-level agreements. 

Additional custom fields. 

Email templates for outgoing notification emails for approvals and assignments (for service calls, incidents, 
problems, projects, changes, and work orders). 

Enhanced metric data collection. 

Ability to configure Service Level Manager (SLM) dimension exports from the HP OpenView console. 

Enhanced metric heartbeat management (metric states are displayed as available, unavailable, or 
unreachable in the HP OpenView console). 

Command-line utility for the HP OpenView console, ovconsolecmd, has been enhanced to accept filter 
parameters from the command line. This enhancement is useful for integrating other programs with the HP 
OpenView console. For example, you can now open a view from the command line that displays all calls 
originating from a particular phone number. 

Console administrators can now create relationship types, and console users can specify those types when 
they create relationships between objects. This enhancement is useful when objects can have multiple kinds 
of relationships with each other. For example, a Configuration Item can be related to an Incident in the 
following ways: Emitting CI, Root Cause CI, Emitting Node, or Impacted Node. 

Hierarchical grouping of forms, views, and actions. Lists of existing forms, views, and actions are now 
grouped by object type in the HP OpenView configuration workspaces. This enhancement enables you to find 
the form, view, or action that you want much more quickly. It also enables you to update certain attribute 
values for multiple forms, views, or actions at the same time.  

Customizable system views for enhanced audit logging. You can now choose the system view used to display 
enhanced audit logging information.  

Reusable classifications and closure codes groups. You can now create reusable classifications and closure 
code groups that are persisted in the HP OpenView database. This enhancement enables you to define m-to-
n relationships between objects. Defining relationships in this way enables you to restrict the values from 
which a console user can choose for a particular field on a form. You can add this restriction by using the 
“Limit field value range by relations” action in a UI rule. 

Ability to create new objects by using templates with missing required fields. It is now possible to use a 
template that does not contain values for all required fields as a nested template. When the template is used 
to populate the values of a form, and such a nested template is used, the console user is prompted to provide 
the missing required field values. 

Ability to audit configuration settings. If you log on to the console by using an account with the Auditor role, 
you can audit changes — including additions, modifications, or deletions — that take place in the  
HP OpenView Configuration workspace. 

Ability to select certain email attachments for Database rules. This feature enables you to send certain 
attachments to certain email recipient groups when a database rule that specifies the “Send email message” 
action is triggered. 
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Configuration Exchange improvements. The following improvements were made to the Configuration 
Exchange function: selectively blocking or unblocking objects, including copy fields and audit rules, 
enhanced log file readability, improved run-time messaging, and including the references audit (list of 
blocked or deleted objects that are still referenced by other objects). 

Secure FTP option for attachments. A configuration option in the administrator console now enables you to 
send and receive attachments by using Secure FTP (FTPS). 

Option to apply a view filter in Advanced Find. If you enable this option in the General Settings dialog box, 
when console users launch the Advanced Find function, the filter operating on the current view (if any) is 
also applied to their search results. Users can also select a different view to display the search results. 

Condition field prepopulated in Advanced Find. If you open the Advanced Find dialog box by pressing F2 
from a look-up field, the summary filter criteria field is prepopulated, based on the value of that attribute. 

Central control of the automatic refresh interval. The HP OpenView console administrator can now exercise 
central control over the interval at which the console clients refresh the active view with information from 
the database. If you do not select this option, console users whose roles permit them to do so can set their 
own refresh intervals. 

“Older Than” and “Newer Than” conditions available in Advanced Find. You can now search for objects 
based on the values of certain date- and time-related attributes. You can specify all objects older or newer 
than a specified number of days. 

Smart action fields can now contain carriage-return and line-feed (CR/LF) characters. You can now embed 
CR/LF characters in a smart action field. This enhancement enables you to specify more than one command 
in a smart action. 

UI rules can now be triggered by up and down arrows on a form. When you click the up or down arrow 
buttons on a form, the selection in the current view moves up or down accordingly, and the form for the 
selected object is opened. You can now trigger a UI rule when the selection changes as a result of clicking up 
or down. 

New Rules log files track Rule Manager debugging messages: INFO, WARN, SEVERE, and FINE. (The 
system log file continues to hold Rule Manager non-debug messages.) 

Automatic three retries if a Data Update or Data Exchange action fails. 

Emails initiated by Database rules can include attachments, and can specify a group (category) of 
attachments. 

Emails initiated by Database rules can now go to multiple addresses. Each address is separated by a 
semicolon (;). 

New action choice is available: Limit field range by relations. 

The following triggers can now be launched by agents on other systems (for example, a Web API or an email 
interface), and can launch a database event that can potentially trigger another event: 

— When a value has changed 

— After an item has been opened 

— After a new item has been opened 

— After an existing item has been opened 

— Before an item is saved 
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The following actions are now executed in the background: 

— Update Data 

— Limit field value range 

— User Notification message 

— Data Exchange with an external system 

— Command Exec Action (executed on the server, not the client machine) 

NOTE: Rules can trigger other rules. As you add rules, make sure you do not create loops, which can 
lead to problems with system stability and data integrity. History lines have an additional 64KB 
attribute field named New Value, so more of the history information is visible. 

Object relationship management enhancements: 

— Relate arbitrary objects. For example, create a UI rule action that, when triggered, restricts the 
available values a user can choose for a field. Or limit the range of relations between a particular entity 
and the set of all possible values. 

— Auditing of relationships between objects now allows auditing of many-to-many relations.  

For information about the differences between HP OpenView Service Desk 4.5 and HP OpenView Service 
Desk 5.0, refer to HP OpenView Service Desk 5.0 Differences Between 4.5 and 5.0/5.1. 

For information about tracing, logging, and troubleshooting, refer to the new HP OpenView Service Desk 
Support Guide. 

For information about the versions of the integrated products with which Service Desk can integrate, refer 
to the Supported Platforms list at this URL: 

http://openview.hp.com/ecare/getsupportdoc?docid=OV-EN020917  

For information about the integration with HP OpenView Operations, refer to the HP OpenView Service 
Desk Operations Integration Administrator’s Guide. For information about other integrations, refer to the 
HP OpenView Service Desk Data Exchange Administrator’s Guide. These guides are delivered in the 
integration release of which they form a part. They are not delivered in Service Desk 5.10. 

http://openview.hp.com/ecare/getsupportdoc?docid=OV-EN020917
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

Version number, which indicates the software version.  

Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html
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Installation Notes 
Installation requirements and instructions for installing Service Desk are documented in the HP OpenView 
Service Desk 5.1 Installation Guide, provided in Adobe Acrobat (.pdf) format. 

Installation Problems 

This section provides workarounds to known installation problems. 

Installation Problems on Solaris 9 and 10 

Problem 

On Solaris, a Finalize action warning error is displayed at the end of the installation. The application 
installer tries to start all the processes, and the ovobs process fails.  

The error message states the following: 

Finalize action for HP OpenView Service Desk Management  

Server (Starting the server.) was not successful. 

The following shows the status after the installation: 

Ovcd        OV Control                       CORE         (2434)   Running 

ovbbccb     OV Communication Broker          CORE         (2435)   Running 

ovloginsv   OV Login Server                  JAVA                  Stopped 

ovapacheA   OV Apache(A) WebServer Service   WEB                   Aborted 

ovsdma      OV SLM OVSD Metric Adapter       SLM          (2757)   Running 

ovtomcatA   OV Tomcat(A) Servlet Container   WEB          (2625)   Running 

ovsdslm     OV Service Level Management      SLM          (2762)   Running 

ovobs       OV Object Server                 OBS                   Aborted 

ovcs        OV Certificate Server            SERVER       (2763)   Running 

ovsdreport  OV Service Desk Reporting        SDREPORT              Aborted 

This problem is linked to the value of the timeout of the OV Control process, which is too small for Solaris 
systems.  

Workaround 

Enter the following commands: 

1 ovc –kill 

2 ovconfchg -ns ctrl.ovcd -set ACTION_TIMEOUT 120 

3 ovc -start 
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QXCR1000315787: 
Apache Startup 

Problem 

For all UNIX systems in an NIS-controlled environment, the OvApacheA package, installed during the 
Service Desk management server installation, does not create the user ovwebusr and the group ovwebgrp.  

Workaround 

To solve this problem, create the user ovwebusr and the group ovwebgrp manually on the Network 
Information Service (NIS) server after installing the OvApacheA product but before starting the OvApacheA 
WebServer service. 

Follow these steps: 

1 Add a group:  

groupadd ovwebgrp 

2 Add the ovwebusr group: 

useradd -G ovwebgrp ovwebusr 

3 Restart the Apache process: 

ovc -start ovapacheA 

Installation Freezes 

Problem 

If the installation screen remains static for a very long time, your machine may have frozen. 

Workaround 

To prevent the installation from freezing, follow these steps: 

1 Download the scripten.exe file from the Microsoft web site: 

http://www.microsoft.com 

2 Run the scripten.exe file. 

3 Restart your computer. 

4 Run the setup.exe file again. 

http://www.microsoft.com/
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Error Messages in the Log Files 

Problem 

You encounter error messages in the following log file: 

C:\Program Files\HP OpenView\data\log\system0.0.en_US 

Example: 

Oct 18, 2005 9:01:48 AM;5;10;com.hp.ov.obs;SEVERE;SQL Exception: JDBC error 942: 
ORA-00942: table or view does not exist, SQL state: 42000 for query: select 1 from 
itsm_personsjava.sql.SQLException: ORA-00942: table or view does not exist 

Workaround 

None. Do not be alarmed. These messages do not impact the behavior of the application. 
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Enhancements and Fixes 
This section describes major new features, as well as fixes for defects raised by customers, in Service Desk 
5.10 Patch 16 (current release), Service Desk 5.10 Patch 15 (previous release), Service Desk 5.10 Patch 14, 
Service Desk 5.10 Patch 13, Service Desk 5.10 Patch 12, Service Desk 5.10 Patch 11, Service Desk 5.10 
Patch 10, Service Desk 5.10 Patch 9, Service Desk 5.10 Patch 8, Service Desk 5.10 Patch 7, Service Desk 
5.10 Patch 6, Service Desk 5.10 Patch 5, Service Desk 5.10 Patch 4, Service Desk 5.10 Patch 3, Service Desk 
5.10 Patch 2, Service Desk 5.10 Patch 1, and Service Desk 5.10. 

Enhancements: 
Service Desk 5.10 Patch 16 

This section describes major new features in Service Desk 5.10 Patch 16.  

Enhancement Description 

QXCR1001094574 Support Windows Server 2008 R2 Enterprise Edition (64-bit) 

QXCR1001094576 Support Oracle 11gR2 

QXCR1001094578 Support Service Desk 5.1 Client on Microsoft Window 7 (64-bit) 

QXCR1001094574: 
Support Windows Server 2008 R2 Enterprise Edition (64-bit) 

Problem  

Service Desk 5.10 did not support Windows Server 2008 R2, and a customer requested for this support. 

Solution 

Provide support for Service Desk 5.10 to run on top of Window Server 2008 R2 Enterprise Edition. 

QXCR1001094576: 
Support Oracle 11gR2 

Problem  

Oracle 11gR1 Premier Support ends in August 2012. Support for Oracle 11gR2 Edition is needed to address 
the impact on Service Desk 5.10. 

Solution 

Provide support for Service Desk 5.10 to run on top of Oracle 11gR2 edition. 

QXCR1001094578: 
Support Service Desk 5.1 Client on Microsoft Window 7 (64-bit) 

Problem  

Service Desk 5.10 does not support Microsoft Window 7(64-bit). 
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Solution 

Provide support for Service Desk 5.10 Client to run on top of Microsoft Windows 7 (64-bit), including 
Professional, Enterprise and Ultimate Editions from this patch. 

Enhancements: 
Service Desk 5.10 Patch 15 

This section describes major new features in Service Desk 5.10 Patch 15.  

Enhancement Description 

QXCR1001023123 Support for SQL Server 2008 Enterprise Edition 

QXCR1001051878 Support Service Desk 5.1 Client on Microsoft Window 7 

QXCR1000350858 Enable deleting multiple selected CIs even some of them have relations to other CIs

QXCR1001023123: 
Support for SQL Server 2008 Enterprise Edition 

Problem  

Microsoft SQL Server 2003 Mainstream Support retires on April 12, 2011. Support for SQL Server 2008 
Enterprise Edition is needed to address the impact on Service Desk 5.10. 

Solution 

Provide support for Service Desk 5.10 to run on top of SQL Server 2008 Enterprise Edition. 

QXCR1001051878: 
Support Service Desk 5.1 Client on Microsoft Window 7 

Problem  

Service Desk 5.10 does not support Microsoft Window 7. 

Solution 

Support Service Desk 5.1 client on Microsoft Window 7 starting from Service Desk 5.10 Patch 15. This patch 
supports Microsoft Windows 7 (32-bit), including Professional, Enterprise and Ultimate Editions. 

QXCR1000350858: 
Enable deletion of multiple selected CIs even if some of them have relations to other CIs. 

Problem 

When deleting multiple Configuration Items at the same time, the deletion process is interrupted by a 
prompt window if one or more of them have relations to other Configuration Items. In addition, it is 
inconvenient that the Configuration Items that have relations to other Configuration Items are not shown in 
the prompt window. 
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Solution 

Enable deleting multiple Configuration Items without relations at once, and prompt a dialog to show items 
that are failed to be deleted due to having relations to other Configuration Items. 

Enhancements: 
Service Desk 5.10 Patch 14 

This section describes major new features in Service Desk 5.10 Patch 14.  

Enhancement Description 

QXCR1000991712 Support for Windows Server 2008 Enterprise x86 (32-bit). 

QXCR1000991712: 
Support for Windows Server 2008 Enterprise x86 (32-bit). 

As Microsoft announced, Windows Server 2003 Mainstream Support retires on July 13, 2010. Service Desk 
5.10 uses Windows Server 2003 as its main platform of Window operating system. Therefore, we need to 
provide support for Windows Server 2008 Enterprise x86(32bit) to avoid the impact. 

Solution 

Provide support for Service Desk 5.10 to run on top of Window Server 2008 Enterprise x86 (32-bit) edition 
normally. 

NOTE: For Service Desk 5.10 to function properly, make sure to turn off the UAC option of Windows 2008. 

To turn off the UAC option of Windows 2008, do the following: 

Make sure that you have the administrator privilege of Windows 2008. 

Locate the UAC setting by clicking Control Panel → User Accounts → Turn User Account Control on or off. 

Uncheck Use User Account Control (UAC) to help protect your computer option. 

Restart Windows 2008. 

Enhancements: 
Service Desk 5.10 Patch 13 

There is no enhancement implemented in Service Desk 5.10 Patch 13. 

Enhancements: 
Service Desk 5.10 Patch 12 

This section describes major new features in Service Desk 5.10 Patch 12.  

Enhancement Description 

QXCR1000889286 Support JRE 1.6 in Service Desk 5.10. 
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QXCR1000889286: 
Support JRE 1.6 in Service Desk 5.10 

Problem 

As Sun announced, Java SE 1.5 will reach its End of Service Life (EOSL) on October 30, 2009. Service Desk 
5.10 uses JRE1.5 as its Java run-time environment. So we need to support JRE 1.6 to avoid the affects of  
Java EOSL. 

Solution 

Upgrade OvJREB1.5 in the Service Desk 5.10 installer to OvJREB1.6 and make sure that Service Desk 5.10 
can run on top of JRE 1.6 normally. 

Enhancements: 
Service Desk 5.10 Patch 11 

This section describes major new features in Service Desk 5.10 Patch 11.  

Enhancement Description 

QXCR1000899740 Implement the HPCSS requirement for executable files on the Windows platform.

QXCR1000899740: 
Implement the HPCSS Requirement for Executable Files on the Windows Platform 

Problem  

Customers need to manage their security risks and expect to use industry-standard methods to validate the 
authenticity and integrity of code delivered to them by HP. In addition, digital signing of some Windows 
objects avoids pop-up warnings that require special attention. 

Solution 

Sign all .exe, .msi, and .js executables of the Windows installer with the HP Code Signing Service. 

Enhancements: 
Service Desk 5.10 Patch 10 

This section describes major new features in Service Desk 5.10 Patch 10.  

Enhancement Description 

QXCR1000397335 Not possible to add attachments by using drag and drop if no attachment is present.

QXCR1000397335: 
Not Possible to Add Attachments by Using Drag and Drop if No Attachment is Present 
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Problem 

It is not possible to drag and drop an attachment from the desktop or an explorer window onto a record 
unless there is already at least one attachment and the attachment panel is visible. 

Solution 

Drag and drop files onto the form directly, then add the files as attachments. 

Enhancements: 
Service Desk 5.10 Patch 9 

This section describes major new features in Service Desk 5.10 Patch 9.  

Enhancement Description 

QXCR1000778599 Server Monitor log file. 

QXCR1000778602 Improve hotfix mechanism. 

QXCR1000778599: 
Server Monitor log file 

Problem 

Server Monitor log file is unable to save captured information for Server Monitor. 

Solution 

As of Service Desk 5.10 Patch 9, Server Monitor has an option in the menu to save the current information 
to the file. The log file can be plain text format or CSV format. 

QXCR1000778602: 
Improve hotfix mechanism 

Problem 

Improve hotfix mechanism. 

Solution 

Hotfix manager is an enhancement to HP OpenView Service Desk 5.10 that improves the efficiency of 
deploying hotfixes. It provides a command-line tool to help Service Desk administrators manage hotfixes in 
an integrated manner. The automatic deployment functionality of hotfix manager significantly reduces the 
effort to deploy hotfixes for Service Desk clients. 

For detailed information, refer to the HP OpenView Service Desk 5.10 Patch 9 Hotfix Management Guide. 

Enhancements: 
Service Desk 5.10 Patch 8 

This section describes major new features in Service Desk 5.10 Patch 8.  
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Enhancement Description 

QXCR1000414502 Specify the Oracle service name during Service Desk 5.x installation. 

QXCR1000760195 Housekeeping of files created by SDSLM/NETIF. 

QXCR1000778596  Support tool collects more log files. 

QXCR1000414502: 
Specify the Oracle Service Name During Service Desk 5.x Installation 

Problem  

Service Desk 5.x does not support an Oracle service name during installation. 

Solution 

As of Service Desk 5.10 Patch 8, Service Desk 5.1 supports an Oracle service name during installation.  

Specifying the Oracle Service Name on Windows 

To specify the Oracle service name during Service Desk 5.x installation on Windows, follow these steps:  

1 Right-click My Computer on your desktop. 

2 In the shortcut menu, select Properties. 

3 In the System Properties dialog box, select the Advanced tab. 

4 Select Environment Variables. 

5 Make sure there is no OvConnType environment variable in System Variables.  

6 In the New System Varibles dialog box, add the following: 

— Variable Name: OvConnType 

— Variable Value: OracleThinServiceName  

 

7 Install a Service Desk 5.1 Patch 8 management server with an Oracle Database. 

8 In the database configuration page of installation wizard, add a valid Oracle service name in the 
Instance field.  
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9 Click Next and continue the installation until finished. 

Specifying the Oracle Service Name on UNIX 

To specify the Oracle service name during Service Desk 5.x installation on UNIX, follow these steps:  

1 Make sure there is no existing OvConnType environment variable on the machine. 

2 Define a new environment variable, as follows: 

— Variable Name: OvConnType 

— Variable Value: OracleThinServiceName  

You can define the variable by entering following command: 

#export OvConnType=OracleThinServiceName   

NOTE: The OvConnType environment variable is used in the installation phase only. After installation 
completes, you do not need it any more. 

3 Install a Service Desk 5.1 Patch 8 management server with an Oracle Database. 

4 In the database configuration page of the installation wizard, add a valid Oracle service name in the 
Instance field.  

For a graphic of the database configuration page of the installation wizard, see the Windows procedure.  

5 Click Next and continue the installation until finished. 
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QXCR1000760195: 
Housekeeping of Files Created by SDSLM/NETIF 

Problem  

When exporting Service Desk changes and problems, temporary files are generated. 

Sometimes, these files fill up the following temporary directories:  

Windows 

<OVPI_Installer>\data\netif\tmp\data\arch 

UNIX 

<OVPI_Installer>/data/netif/tmp/data/arch 

Solution 

You can configure your system to keep or remove the temporary files.  

To configure temporary files on Windows, follow these steps: 

1 Go to the following directory: 

— Windows 

<OvInstallDir>\bin 

— UNIX 

<OvInstallDir>/bin   

2 Check the value of the following: 

[entityExporter.configSrv.ovpiExporter]\disposition; 

Enter one of the following commands: 

— Windows 

Ovconfget 

— UNIX 

ovconfget.sh 

You see one or both of the following values: 

— true 

Temporary files that are kept after exporting. 

— false 

Temporary files that are removed automatically after exporting.   

3 Enter the following command: 

ovconfchg -ns entityExporter.configSrv.ovpiExporter -set disposition %value% 

In this command, %value% represents true or false.  

The command changes the value of the following: 

[entityExporter.configSrv.ovpiExporter]\disposition 

4 Enter the following command: 

ovc -restart ovsdreport 
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QXCR1000778596: 
Support Tool Cannot Collect OvTomcat and OvApache Log Files Automatically 

Problem  

The Service Desk 5.x support tool cannot collect OvTomcat and OvApache log files. 

Solution 

As of Service Desk 5.10 Patch 8, the Service Desk 5.1 support tool can collect more log file information.  

Compared to the previous support tool, the new version can automatically collect OvTomcat and OvApache 
log files, as well as all files in the following directories: 

Windows 

%OVINSTALLDIR%\bin 

UNIX 

/opt/OV/bin   

Enhancements: 
Service Desk 5.10 Patch 7 

This section describes major new features in Service Desk 5.10 Patch 7.  

Enhancement Description 

QXCR1000341751 OvSDBanner does not have color parameters like banner.exe. 

QXCR1000371528 Map view zoom feature enhancement. 

QXCR1000381338 Time zone change required for Australia (Perth). 

QXCR1000341751: 
OvSDBanner Does Not Have Color Parameters Like banner.exe 

Problem  

Original OvSDBanner does not have color parameters like banner.exe in Service Desk 4.5. 

Solution 

As of Service Desk 510 Path 7, OvSDBanner has color parameters. For example, OvSDBanner.exe /red 
pops up a red banner. 
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QXCR1000371528: 
Map View Zoom Feature Enhancement 

Problem  

The map view zoom feature does not work as required. If there are a large number of objects represented in 
a map view, they are rendered very small. If the zoom value is increased, it increases the size of the 
background, objects, and labels. Although the background, objects, and labels become larger, the object 
labels still overlap (that is, they are still unreadable). 

Solution 

The labels no longer overlap when the names are very long. The objects are readable. 

QXCR1000381338: 
Time Zone Change Required for Australia (Perth) 

Problem  

Service Desk has a time zone for Australia (Perth) UTC + 8.00 with no Daylight Saving Time. Local state 
government recently passed legislation to start Daylight Saving Time from December 3, 2006. Daylight 
Saving Time starts on the last Sunday in October. It ends on the last Sunday in March. 

Solution 

As of Service Desk 5.10 Patch 6, you can use the daylight time zone for Australia (Perth) correctly. In Patch 
5 and earlier, you can use DST tool supported by Sun Microsystems to update the JRE/JDK manually. 

Enhancements: 
Service Desk 5.10 Patch 6 

This section describes major new features in Service Desk 5.10 Patch 6.  

Enhancement Description 

QXCR1000383560 Support Service Desk 5.x client on Microsoft Vista. 

QXCR1000714629 Remove the SHS component from Service Desk 5.1 since Patch 6. 

QXCR1000764553 Support JRE 1.5 since Service Desk 5.10 Patch 6. 

QXCR1000383560: 
Support Service Desk 5.x Client on Microsoft Vista 

Problem  

Service Desk 5.10 does not support Microsoft Vista before Service Desk 5.10 Patch 6. 

Solution 

Support Service Desk 5.x client on Microsoft Vista since Service Desk 5.10 Patch 6. This patch supports 
Windows Vista Enterprise Edition only. 
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QXCR1000714629: 
Remove the SHS Component from Service Desk 5.1 Since Patch 6 

Problem  

The SHS component is deprecated. 

Solution 

SHS component was removed in Service Desk 5.10 Patch 6. 

QXCR1000764553: 
Support JRE 1.5 Since Service Desk 5.10 Patch 6 

Problem  

Service Desk 5.10 does not support JRE 1.5 before Service Desk 5.10 Patch 6. 

Solution 

JRE 1.5 since Service Desk 5.10 Patch 6. 

Enhancements: 
Service Desk 5.10 Patch 5 

This section describes major new features in Service Desk 5.10 Patch 5.  

Enhancement Description 

QXCR1000434898 Use JRE 1.4.2_13 as the default JRE for Service Desk Web Start. 

QXCR1000442706 Yes, No, and Cancel buttons are not translated into Portuguese. 

QXCR1000455984 Display hotfix information in the logs. 

OV-EN023545 Support New Zealand DST change in 2007. 

QXCR1000434898: 
Use JRE 1.4.2_13 as the Default JRE for Service Desk Web Start 

Problem  

In the current configuration, JRE 1.4.2_07 is used as the default JRE for the Service Desk Web Start client 
when users launch it through Microsoft Internet Explorer. 

Solution 

Use JRE 1.4.2_13 as the default JRE for the Service Desk Web Start client. 
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QXCR1000442706: 
Yes, No, and Cancel Buttons are Not Translated into Portuguese 

Problem  

After the installation of the Language Pack, the Yes, No, and Cancel dialog boxes are not translated into 
Portuguese.  

Solution 

Now, the Yes, No, and Cancel dialog boxes are translated into Portuguese 

QXCR1000455984: 
Display Hotfix Information in the Logs 

Problem  

After deploying a sign jar hotfix, support engineers and customers cannot see hotfix information.  

Solution 

Now, hotfix information is recorded in a log file when the system starts up.  

The hotfix information looks like this: 

Aug 10, 2007 2:29:39 
PM;1;10;com.hp.ov.obs.startup.Launcher;getHotfixInfo;com.hp.ov.obs;INFO;><Hotfix - 
QXCR1000419356 installed for module library C:\Program Files\HP 
OpenView\java\hotfix\hotfix_OvObsCommon.jar 

OV-EN023545: 
Support New Zealand DST change in 2007 

For details, see the following web site: 

http://openview.hp.com/ecare/getsupportdoc?docid=OV-EN023545 

Enhancements: 
Service Desk 5.10 Patch 4 

This section describes major new features in Service Desk 5.10 Patch 4.  

QXCR1000420461: 
Entity Changed DB Rule Does Not Trigger UI Rule  

Problem  

In some conditions, a UI rule can be trigged by a DB rule. This can cause some unexpected behaviors. 

Solution 

UI Rule is not triggered by a DB rule again.  

http://openview.hp.com/ecare/getsupportdoc?docid=OV-EN023545
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QXCR1000410151: 
Unique Field Setting Cannot Be Imported by Configuration Exchange Again 

Problem  

The configuration import functionality does not check the unique field restriction when importing. This can 
cause some duplicate unique fields in the database. The upgrade fails when it checks unique fields.  

Solution 

The configuration import functionality checks the unique field restriction when importing data. 

Enhancements: 
Service Desk 5.10 Patch 3 

This section describes major new features in Service Desk 5.10 Patch 3.  

QXCR1000405657: 
Database Upgrade Fails Because of OutOfMemory Issue 

Problem  

If customer database has many configuration settings, the upgrade to Service Desk 5.10 Patch 2 fails, and 
the log shows an “out of memory” message. 

Solution 

Adjust the maximum memory for Java by setting the environment variable OV_OPTS. 

Windows example: 

OV_OPTS = “-Xms64M -Xmx512M”  

If the upgrade process encounters an OutOfMemory issue, change the OV_OPTS environment variable to the 
proper value. 

Enhancements: 
Service Desk 5.10 Patch 2 

This section describes major new features in Service Desk 5.10 Patch 2.  

Enhancement Description 

QXCR1000313889 SHOW fields in Service Desk 5.0. 

QXCR1000325476 Fields missing in the DB Rule action to configure an update of related service events. 

QXCR1000347192 No way to refresh the Combination view. 

QXCR1000348778 Assigning roles or including roles is time-consuming. 

QXCR1000382977 Paste functionality with the mouse is not available on objects. 

QXCR1000379214 Application running on an older JRE 1.4 reports the incorrect time. 
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QXCR1000379214: 
Application Running on an Older JRE 1.4 Reports the Incorrect Time  

Problem 

For Service Desk 5.10 Patch 2, the JDK and JRE were upgraded from 1.4.2_08 to 1.4.2_11. The upgrade 
enables support of 2007 U.S. Daylight Saving Time (DST) and the Energy Policy Act of 2005. 

Workaround  

Most of the time zones in Service Desk work well after updating, but the information of some other time 
zones is inconsistent. For details, see Known Problems, Limitations, and Workarounds.  

Enhancements: 
Service Desk 5.10 Patch 1  

This section describes major new features in Service Desk 5.10 Patch 1.  

Enhancement Description 

QXCR1000387427 Would like to have support for Microsoft SQL Server 2005 for Service Desk 5.10. 

QXCR1000387443 Would like to have support for Microsoft SQL 2000 Cluster. 

QXCR1000388539: 
Support of 2007 U.S. Daylight Saving Time (DST) and the Energy Policy Act of 2005 

Problem 

Java 1.4.1_11 is required to make the system compliant with 2007 U.S. Daylight Saving Time (DST) and the 
Energy Policy Act of 2005.  

Workaround 

For all Service Desk 5.x versions as of January 2007, SDSK_00107 was submitted to the SSO website, which 
contains a Sun tool named “tzupdater.” The tzupdater tool enables you to update installed JDK and JRE 
images with the most recent time zone data to accommodate the 2007 U.S. Daylight Saving Time (DST) 
changes. These time zone changes were brought into force by the U.S. Energy Policy Act of 2005.   

Solution 

Service Desk 5.10 Patch 2 upgrades to the Java version that contains the correct time zone data. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=926598&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=926696&template=view&tableid=1003
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Enhancements: 
Service Desk 5.10 

This section describes major new features in Service Desk 5.10. 

Self-Healing Services 

Self-Healing Services software is shipped with this release. It is included when you install the Service Desk 
management server software.  

To access the Self-Healing Services software: 

1 Open a web browser, and go to the following location: 

https://localhost:8443/SAM 

2 Use the default username and password combination:  

admin/admin 

Self-Healing Services software can be used to gather and submit data needed to streamline the resolution of 
problems found in Service Desk 5.10. HP recommends the use of Self-Healing Services, which is included in 
every support contract.  

Documentation and downloads are available at the following location: 

http://support.openview.hp.com/self_healing.jsp. 

The automatic submission of troubleshooting data to GP Support requires the installation of the HP Instant 
Support Enterprise Edition (ISEE) software.  

You can get this software from the following location: 

http://support.openview.hp.com/self_healing_downloads.jsp 

To enable or disable Self-Healing Services software: 

To disable the Support Automation Manager (SAM) web application, enter the following command:  

— Windows 

cscript %OVINSTALLDIR%/bin/shsctrl.vbs –disablesam  

— UNIX 

/opt/OV/bin/shsctrl –disablesam  

To enable the SAM web application, enter the following command.  

— Windows  

cscript %OVINSTALLDIR%/bin/shsctrl.vbs –enablesam  

— UNIX 

/opt/OV/bin/shsctrl –enablesam  

The disable option unregisters the SAM web application. The enable option registers it. 

If the ovtomcatA service is running when you disable or enable the SAM web application by using the above 
commands, you need to restart the ovtomcatA service for the changes to take effect. 

https://localhost:8443/SAM
http://support.openview.hp.com/self_healing.jsp
http://support.openview.hp.com/self_healing_downloads.jsp
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Fixes: 
Service Desk 5.10 Patch 16 

This section describes defects fixed by Service Desk 5.10 Patch 16. 

Defect Description 

QXCR1000831568 Auditing of CI Un-relating does not work with the SD Web API 

QXCR1000827947 Auditing of CI Un-relating not working as expected 

Fixes: 
Service Desk 5.10 Patch 15 

This section describes defects fixed by Service Desk 5.10 Patch 15. 

Defect Description 

QXCR1000241634 Advanced Find with a string ID causes three error messages 

QXCR1000330467 CME3.1 IC1: Advanced Find "Older Than (Days)" value is not editable 

QXCR1000343758 Error log file is not stored in the same directory as the default log file 

QXCR1000344520 New Smart Action is disabled 

QXCR1000350858 Enable deletion of multiple CIs even if some of them have relations to other CIs 

QXCR1000357924 Required Fields attribute list and keyboard keys (up/down) do not change focus of it 

QXCR1000395400 The required field setting get lost after upgrade  

QXCR1000889334 Invalid view can be saved by view action 

QXCR1000889727 Invalid view can be saved by explorer view 

QXCR1000971578 Format rule condition with date and number field cannot be updated correctly 

QXCR1001043868 In the new data import window, error occurs if un-matched entity is provided 

QXCR1001046111 Flickering screen when opening drop-down menu in combination with search screen 

Fixes: 
Service Desk 5.10 Patch 14 

This section describes defects fixed by Service Desk 5.10 Patch 14. 

Defect Description 

QXCR1000306291 Missing Relations when using System Action "Create Workorder ...." 

QXCR1000325481 Specialist can't use inbound email to log a Service Call. 

QXCR1000328248 Online Help: Active Directory User Authentication is not explained well enough. 

QXCR1000427923 When attach a file to a subcontract call, SD attaches it to the initial one. 

QXCR1000862871 ovc server can not start if the indicated FTP server does not exist. 

QXCR1000866274 Open URL only presents in context menu when selecting from right to left.  
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QXCR1000889297 The system pops up JDBC Error message when you edit the view with non-sys account. 

QXCR1000889753 An email is sent twice if there is no condition in the DB rule. 

QXCR1000951219 Quick Find displays incorrect relation for a copied reference. 

QXCR1000952652 The UI rule is unable to execute when condition contains operator '>=1 year age. 

QXCR1000955572 Copy Field does not work for entities created by actions. 

QXCR1000959144 Blocked codes are visible for all users in Update All dialog. 

QXCR1000962341 After closing smart action dialog in the UI Rule, a NullPointerException pops up. 

QXCR1000963821 After clearing Caller and entering new Caller, SD does not recognize searchcode 

QXCR1000972014 Can not copy attachments using drag and drop. 

QXCR1000980568 Local view problem. 

QXCR1000987921 Drag and drop can create duplicated relation if Reference attribute is audited. 

QXCR1000989210 The WebConsole can not display chart view if SD server is on the Unix platform. 

QXCR1000994488 Could not create a new Reference for Workorder due to default search view option. 

QXCR1000994491 Could not add multiple References to Workorder. 

Fixes: 
Service Desk 5.10 Patch 13 

This section describes defects fixed by Service Desk 5.10 Patch 13. 

Defect Description 

QXCR1000361838 An error message appears if selecting an existing Service Today record during creation 
of a new record form. 

QXCR1000388128 Java error Assertion Failed appears when relating items on Web console. 

QXCR1000468901 After configuration exchange import, you have to clear cache and restart the server to 
see the change. 

QXCR1000806893 Attachment classification codes can not be displayed properly in the entities. 

Defect Description 

QXCR1000815984 Changing time manually in Advanced Find is not possible. 

QXCR1000829147 Can not change the parent/child relation of CIs in the explorer view. 

QXCR1000841761 The Template field is not Read-Only after saving an item. 

QXCR1000841810 A java.lang.nullpointerexception exception occurs when using find (F3) after 
changing views. 

QXCR1000844714 Unexpected behavior occurs when manually changing time filters. 

QXCR1000889055 Triggering a UI rule with system action opens multiple forms. 

QXCR1000889061 When CI Category field is set to View in Roles by the administrator, it is still 
writable for users. 

QXCR1000910013 IDs skipped when records are created via Web API if ID after Creation checkbox is 
deselected. 
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QXCR1000914298 A defect occurs when entering numeric values with more than five digits in Advance 
Find. 

QXCR1000924759 Can not save or open SLM-SLO if add a particular custom field to the form. 

QXCR1000930578 Existing attachments cannot be opened after upgrading from 5.1 Patch 3 to Patch 10. 

QXCR1000931077 Log information of debug hotfix in log file. 

QXCR1000939508 Performance Issue: User session hangs when relating service to SLA. 

QXCR1000939523 SD / PI reports inconsistency. 

QXCR1000949088 PDF attachments are opened twice. 

QXCR1000953048 Serialization error while reading ResultSet due to 
ArrayIndexOutOfBoundsException. 

QXCR1000953552 Classification and Category lookup changed behavior to case-sensitive. 

QXCR1000968254 Audit history of Service Event Relation only shows relation addition but not relation 
removal. 

QXCR1000968275 An error message appears when referencing workorders.  

QXCR1000970168 Many SlmCore user session not found errors in log.  

QXCR1000977872 Web console may throw an exception when the label text includes HTML reserved 
characters.  

Important Behavior Changes: 
Service Desk 5.10 Patch 13 

This section describes important behavior changes since Service Desk 5.10 Patch 13. 

QXCR1000829147: 
Can Not Change the Parent/Child Relation of CIs In the Explorer View 

Behavior change:  

In an explorer view, the CI relationships opened from the leaf view are read-only. 

QXCR1000841810: 
A java.lang.nullpointerexception Exception Occurs When Using Find (F3) After Changing Views 

Behavior change:  

The Find dialog closes automatically when user switches to another view or shows the view in a new 
window. 

QXCR1000889055: 
Triggering A UI Rule With System Action Opens Multiple Forms  

Behavior change:  

Create Change action is removed from System Action of UI Rule of Change.  
Create Problem action is removed from System Action of UI Rule of Problem. 
Create Incident action is removed from System Action of UI Rule of Incident.  
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QXCR1000939523: 
SD / PI Reports Inconsistency 

Behavior change:  

A new switch is added to indicate that if the extra flag should be added to the report. The extra flag indicates 
whether the corresponding item is created in the reporting cycle or not.  

How to add/use the switch: 

1 Add a new switch enableNewInCycle in the configuration file sdreporting.ini which is under 
<OVInstallDir>\misc\xpl\config\defaults folder, and set to true as follows:  
bool enableNewInCycle=true 

2 Run <OvInstallDir>\bin\ovconfchg command to save the switch to the control. 

3 Run <OvInstallDir>\bin\ovc -restart ovsdreport command to bring the switch into effect. 

The switch is considered false by default if it is not defined. 

Limitation: 

This new feature must work together with OpenView Performance Insight (OVPI) patch RNS14.10.001 or 
later patches. Although the patch RNS14.10.001 is for OVPI 5.4, the integration between Service Desk 5.10 
and OVPI 5.4 is not officially supported yet. 

QXCR1000953552: 
Classification And Category Lookup Changed Behavior to Case-Sensitive 

Behavior change:  

Searching code-type items, such as Folder, Classification and Category, in Quick Find dialog is not case-
sensitive anymore. 

Fixes: 
Service Desk 5.10 Patch 12 

This section describes defects fixed by Service Desk 5.10 Patch 12. 

Defect Description 

QXCR1000320908 TableView: Sticky selection indicator after a sort or group. 

QXCR1000335739 On UNIX, problems logging on without OvObsClient.conf. 

QXCR1000342486 L10N: Defect in executing the command OVsdarchive. 

QXCR1000361817 Open duration does not show in view. 

QXCR1000367947 Failed to add a related item like Initiator to the Advanced Find of a change. 

QXCR1000381706 Custom field code 1 is activated by default in SD 5.10. 

QXCR1000393056 L10N: Error occurs in SD 5.00 SP1 when checking the ignore client setting option. 

QXCR1000399255 L10N: On Windows 2000, clicking Help on the menu does not open the online help. 

QXCR1000410515 Column Registration;Created By column is not visible in the history lines tab. 

QXCR1000415616 Unable to see the list of related Service Events (Table) from Advanced Find. 

QXCR1000444382 Unable to delete orphaned Code Fields for a Configuration Item. 
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Defect Description 

QXCR1000450164 Printing special character causes a Java error. 

QXCR1000456409 Separators do not work in the web console. 

QXCR1000457935 When opening a hyperlink with CTRL+click, four notepads are shown. 

QXCR1000463095 Outbound email To: <email addresses> line can exceed 1,000 characters. 

QXCR1000463588 Update All on CIs fails with an error message. 

QXCR1000472160 Copy of a person does not correctly reflect attachments. 

QXCR1000713002 Creating a change in the web console encounters a Java exception. 

QXCR1000740000 Advanced Find for Services fails when using the Advanced tab. 

QXCR1000741997 Underpinned Services can relate a service type that is not allowed for a service. 

QXCR1000743974 Service call priority duration is one second off. 

QXCR1000753029 Smart actions of any type are not available to be assigned to a role. 

QXCR1000760583 Filter and Quick Find windows of a view stay in a loop. 

QXCR1000772860 Audited relations in a CI save changes that never happened. 

QXCR1000779629 Changes to the output folder are not saved. 

QXCR1000797100 Unable to open an SC that is edited but not saved by using View Action. 

QXCR1000808852 If the action Own is executed on two or more records, the error dialog displays. 

QXCR1000808941 Log-on screen is not visible when browsing from within SD 5.10. 

QXCR1000813295 Service Pages is not using language settings correctly. 

QXCR1000816127 Right-clicking to insert a page does not work. 

QXCR1000831578 Cannot save the [View] [Match Case] fields value in the Name Filter form. 

QXCR1000831613 Cannot save a table view when adding a special condition in the Format Rules. 

QXCR1000841779 Wildcard (*) in the middle of a string is not allowed when using Quick Find. 

QXCR1000841794 Print range is unavailable. 

QXCR1000851202 History Line Update All permission errors since upgrading to SD 5.10 P7. 

QXCR1000860771 Blocked Classification checklist can be used in the Checklist wizard action. 

QXCR1000861414 System pop-up null point exception when using a default schedule Gantt view. 

QXCR1000863460 CTRL-clicking an URL opens the URL three times. 

QXCR1000885440 Compliance SLO tab under Service causes a client hang and a Java heap space. 

QXCR1000889295 Need to support Oracle 11g in Service Desk 5.10. 

QXCR1000891219 Cannot View/Modify items assigned to the logged on user’s workgroup. 

QXCR1000899224 Get an error when adding a person to a workgroup (Production System). 

QXCR1000899341 Web Start client shows certificate expiration message of OvSecLogin. 

QXCR1000899778 Web Start client shows certificate expiration message of iLog-Gantt. 

QXCR1000903598 Java error when opening a referenced project from a project. 

QXCR1000907304 Text box size changes after attempting a patch upgrade. 

QXCR1000909179 Filter in the Advanced Find does not work for Template. 

QXCR1000930534 View with a periodic refresh leads the client to hang. 
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Defect Description 

QXCR1000934099 NullPointerException is thrown when trying to edit related work orders. 

Important Behavior Changes: 
Service Desk 5.10 Patch 12 

This section describes important behavior changes since Service Desk 5.10 Patch 12. 

QXCR1000841779: 
Wildcard (*) in the Middle of A String is Not Allowed When Using Quick Find 

Behavior change:  

A new JVM parameter ov.sd.quickfind.wildcard.allowed enables you to switch wildcard allowance on 
and off when using Quick Find. 

If the allowance is switched off, the behavior of Quick Find remains unchanged. If the allowance is switched 
on, the wildcard is allowed in Quick Find. 

If the parameter is not added, the switch is considered to be false by default. 

To add the ov.sd.quickfind.wildcard.allowed parameter on Windows, follow these steps: 

1 Open the %OvInstallDir%bin/ovconsole.bat file. 

2 Append the line starting with 'set JVMARGS=' with a new parameter: 

Dov.sd.quickfind.wildcard.allowed=true 

The new statement should look like this: 

set JVMARGS=-Xms64m -Xmx256m -Dsun.java2d.noddraw=true -Dcom.hp.ov.ui.formOpenMax=10 -
DovAppName=OvConsole %XPL_CLIENT_ARGS% -Dov.sd.quickfind.wildcard.allowed=true 

To add the ov.sd.quickfind.wildcard.allowed parameter on UNIX, follow these steps: 

1 Open the /opt/OV/bin/ovconsole file. 

2 Append the line starting with 'JVM_ARGS=' with a new parameter: 

Dov.sd.quickfind.wildcard.allowed=true 

The new statement should look like this: 

JVM_ARGS="-Xms64m -Xmx256m -Dcom.hp.ov.ui.formOpenMax=10 -DovAppName=OvConsole -
Dov.sd.quickfind.wildcard.allowed=true" 

QXCR1000889295: 
Need to Support Oracle 11g in Service Desk 5.10 

Behavior change:  

Rigorous testing indicates that Server Desk 5.10 can work together with Oracle 11g normally. 

Limitations: 

To use the OCI connection type, you can install Service Desk Server with Oracle 10g client but not with 
Oracle 11g. Only Oracle10g OCI features are supported in such a connection type. 
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QXCR1000907304: 
Text Box Size Changes After Attempting a Patch Upgrade 

Behavior change:  

The 4K field can be resized. 

Fixes: 
Service Desk 5.10 Patch 11 

This section describes defects fixed by Service Desk 5.10 Patch 11. 

Defect Description 

QXCR1000304083 Error message is displayed for  disableAutoStartSdMa.bat and 
disableAutoStartSdSlm.bat. 

QXCR1000318930 Data is doubled in the DPIPE table for the SD Reporting Full Export. 

QXCR1000318931 When starting SD Reporting Incremental for the first time, the export is incorrect. 

QXCR1000333375 Folder restricted Roles view all in data in charts. 

QXCR1000335920 Mouse cursor is in the last modified field after the “Save and New” (Service Call).. 

QXCR1000341146 In Security/Roles in Advanced/Fields, the three radio buttons are not working 
correctly. 

QXCR1000344083 User Notification Messages are sent in the wrong format. 

QXCR1000344871 Cannot drag and drop attachments onto a record if none is already there. 

QXCR1000348164 Changing a notification message does not take effect. 

QXCR1000352686 Relating Service to CI or Service throws exceptions using the service hierarchy. 

QXCR1000357945 Inconsistency in (un)relate privileges between OvConsole and WebConsole. 

QXCR1000378168 R:Value modification in Service page view settings cannot be triggered. 

QXCR1000397066 Users can modify templates without having the rights to do so. 

QXCR1000401200 Wrong attachment directory structure. 

QXCR1000403970 Difference in processing between standard and custom required fields set read only…. 

QXCR1000413978 Boolean custom fields show values of True or False in hard copy. 

QXCR1000414886 Some CIs cannot be created with the Generate CI Wizard. 

QXCR1000415862 Error when adding a condition to the format rules of a view. 

QXCR1000419292 System pop-up error when relating an incident in the CI form. 

QXCR1000420577 Cannot relate a workgroup with the administrator role in CI. 

QXCR1000436141 Button to add or delete a category item disappears from Advanced Find. 

QXCR1000440507 Date and Time settings for users are not stored for their accounts. 

QXCR1000451043 Corruption of the integer value to the custom field. 

QXCR1000459363 Cannot export administrator settings for the Sdc module with the OvObsModex 
command. 

QXCR1000460577 System pop-up error when making settings in the project Gantt view. 

QXCR1000468525 Java error when filling out the Assignment with an external organization field.. 
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Defect Description 

QXCR1000741528 Some fields for the Data Source Attribute field On X-Axis tab pop up error…. 

QXCR1000749216 Relate forms error when creating a role. 

QXCR1000763553 Cannot view history lines in service pages. 

QXCR1000765856 Some fields do not show completely under complex conditions settings. 

QXCR1000766472 Schedule Gantt chart view does not work. 

QXCR1000780767 Service Navigator SN status field does not update correctly in the CI form. 

QXCR1000797027 Operators are different under new and edit when creating a UI rule. 

QXCR1000828533 Two types of code, Classification and Closure code, cannot be used. 

QXCR1000829140 Cancel button on the rule window does not prevent an action from being updated. 

QXCR1000835403 New hotfix does not overwrite the old one that has the same defect id. 

QXCR1000846269 Click Quick/AdvancedFind pops up an IllegalArgumentException in the explorer view. 

QXCR1000847430 Query cannot be executed for User Notification Message in Advanced Find. 

QXCR1000847449 Deleted User Notification Message is still displayed in Quick Find. 

QXCR1000847927 Nullpointer exception occurs when setting view properties. 

QXCR1000850037 Contents on the More Choice tab disappears in the Advanced Find. 

QXCR1000851212 History Line view error. 

QXCR1000856133 Deleting DB Rules generates an unexpected exception. 

QXCR1000860268 No arrow displays on grouped columns to show the sorting mode. 

QXCR1000860301 Cannot choose the Application Program to open the attachment file. 

QXCR1000860819 Metric Adapter aborts after it is re-registered by the ovcreg tool on HP-UX. 

QXCR1000863411 Caller identification number is missing in the confirmation email. 

QXCR1000863911 Multiple user sessions are logged after re-activating clients. 

QXCR1000866986 OVConsole local hotfixes are not removed during upgrading. 

QXCR1000867469 Mismatch in concurrent licenses accounting. 

QXCR1000870710 Error on page trying to update a Service Call in the web console. 

QXCR1000880219 Custom fields are still editable after they are de-actived. 

QXCR1000880526 Invalid View can be saved. 

QXCR1000881656 Read-only of the Template Value form does not take effect. 

QXCR1000889194 NullPointerException occur when clicking the clear button in the Service Hierarchy. 

Important Behavior Changes: 
Service Desk 5.10 Patch 11 

This section describes important behavior changes since Service Desk 5.10 Patch 11. 

QXCR1000397066: 
User Can Modify the Templates Without Having the Rights to Do So 
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Behavior change:  

Users are not able to access all templates. They are able to access only the templates for which they have the 
Maintain Templates right on entities. 

QXCR1000414886: 
Some CIs Cannot Be Created with the Generate CI Wizard 

Behavior change:  

Instead of rolling back the whole transaction, the Configuration Items that are fulfilled with the creation 
criteria are generated in case there are failures during the generation. 

QXCR1000460577: 
System Pop-Up Errors When Making Settings in the Project Gantt View 

Behavior change:  

If you choose a custom field for the Start Attribute field or for the End Attribute field, the check box Show 
Change and the check box Show Work Order are set to unchecked and disable. 

After you choose a non-custom field for the Start Attribute field and for the End Attribute field, the check 
box Show Change and the check box Show Work Order is enabled again. 

QXCR1000860268: 
No Arrow Displays on Grouped Columns to Show the Sorting Mode 

Behavior change:  

An arrow icon (without index) shows on the grouped table header. The direction depends on which sorting 
mode (ascending or descending) the users chose. 

Fixes: 
Service Desk 5.10 Patch 10 

This section describes defects fixed by Service Desk 5.10 Patch 10. 

Defect Description 

QXCR1000309374 Registration; Created by person: Menu Quick View or Open Person is not enabled. 

QXCR1000356202 Not all entities are visible in the template screen. 

QXCR1000357907 DB rule to update related records does not offer all fields. 

QXCR1000357941 Unable to open an attachment from service calls with a non-alphanumeric file name. 

QXCR1000358663 View definitions that refer from the Chart view replace the based view. 

QXCR1000360185 Parameters missing in error messages for required fields. 

QXCR1000360189 When an invalid new password is entered, the error message is not complete. 

QXCR1000360221 Minutes of duration fields in entities become one less that what is entered. 

QXCR1000360706 Setting auto format in a view results in a computed error. 

QXCR1000361476 Remove the party object and other entities in the web console. 
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Defect Description 

QXCR1000363505 Checklist functionality: Questions are truncated. 

QXCR1000363839 Show additional time zones option does not work properly. 

QXCR1000364837 IS Metric condition allows free text values instead of comparison operators. 

QXCR1000365371 Y axis function reverts to Average in the chart view. 

QXCR1000370657 Advanced Find search on workgroups without members fails. 

QXCR1000377220 Quick Find problem for services in a subcontract call. 

QXCR1000385276 After Advanced Find is used for awhile, the green arrows are grayed. 

QXCR1000389372 No negative indications with the Average pickup time OVSD metric. 

QXCR1000389529 In a server call, when you select a caller, then select a CI, an exception occurs. 

QXCR1000390401 Web Start Console does not show an error. 

QXCR1000395736 The ovconsolecmd -advanceFind -filter expression does not work. 

QXCR1000400680 Two popups for read-only service calls. 

QXCR1000796648 OVSD 5.1 Accessibility Function. 

QXCR1000806382 SLM/OVPI reports reuse old data when newer data is not available. 

QXCR1000814363 Read-only field becomes editable after a refresh. 

QXCR1000819210 Schedule Gantt Chart View generates a java error. 

QXCR1000823035 Unexpected NullPointerException at com.hp.ov.ui.util.TextComparator.compare. 

QXCR1000823037 Unexpected NullPointerException at AppTableView.getContext. 

QXCR1000823038 Unexpected NullPointerException at 
AbstractCommandManagerImpl.removePropertyCh.... 

QXCR1000823040 Unexpected NullPointerException at BaseFormImpl.getEntity. 

QXCR1000827319 Too many SLM Core User logons in the Service Desk report service. 

QXCR1000853127 Smart Action filter should not contain EntitySet. 

QXCR1000853181 Error when creating a new service call. 

QXCR1000855882 Full client fails to start after applying hotfixes by hotfixshell. 

QXCR1000857701 Hotfix updator does not check enablement of the function before opening the FTP 
server. 

QXCR1000860128 Performance issue: Cache version on the server side does not refresh properly. 

QXCR1000873550 CPU spikes on a Java process every two minutes, causing bad performance. 

Important Behavior Changes: 
Service Desk 5.10 Patch 10 

This section describes important behavior changes since Service Desk 5.10 Patch 10. 

QXCR1000364837: 
IS Metric Condition Allows Free Text Values Instead of Comparison Operators 

Behavior change:  
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Validation is executed before saving the SLA to avoid invalid operators being saved. If the inputted operator 
is invalid, an error message box pops up to prompt users. 

QXCR1000853127: 
Smart Action Filter Should Not Contain EntitySet 

Behavior change:  

The Entity Set type attributes (for example, Roles of Person, Work Orders, and Referenced From) are 
filtered out from the attribute selection menu in the Smart Action condition panel. 

Fixes: 
Service Desk 5.10 Patch 9  

This section describes defects fixed by Service Desk 5.10 Patch 9. 

Defect Description 

QXCR1000325490 Sorting over columns in required field configuration is not possible. 

QXCR1000325727 Faulty form for Address Domain, Node, etc., in Quick Find... 

QXCR1000343752 Unable to sort on Internal Attribute field in Entity Mapping form. 

QXCR1000344135 Search criteria are visible after deleting its Advanced Find "named filter". 

QXCR1000346280 State in Location displayed as Status if State in Incident renamed to Status. 

QXCR1000354215 R: Template value cannot be set to History lines. 

QXCR1000354556 Summary field of Schedule entity does not store the value entered. 

QXCR1000355138 Navigating records through advanced find using Previous and Next button. 

QXCR1000396655 Errors in trend.log and no data in Service Desk report pack. 

QXCR1000399183 Inconsistent security settings between services and CI. 

QXCR1000430532 Set some fields to be read only, failed to new a CI or relate CI to change. 

QXCR1000760179 System popup S NullPointException error when create new template in the role. 

QXCR1000780251 Service Call deadline can be set before registration created date 

QXCR1000781491 The entity can't be saved after setting attachment classificiation 

QXCR1000786152 Table REP_HVT_TRANSACTION_ENTITIES in Oracle 10.1 for SD/SLM increases 
very fast. 

QXCR1000790540 Problem to create a Service call in Service pages when Service is required file. 

QXCR1000790895 Upgrade process cannot clear existing hotfix(s) automatically. 

QXCR1000791780 Audit Work order-CI relation with detailed references information instead of OI. 

QXCR1000795119 Update all has no effect when value is 'make empty.' 

QXCR1000796180 Bug in pie chart view. 

QXCR1000803583 Attributes embedded into email body of DB Rule do not support nested brackets. 

QXCR1000804162 Text 64k custom field is decreased/shrunk to unreadable size. 

QXCR1000804226 ovslmdimexp service stopped when logging off the terminal service. 

QXCR1000813140 Problem with data exchange reconciliation. 
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Defect Description 

QXCR1000813288 Upgrade failed on HPOvSlmMo after updating system role in SLM account. 

Important Behavior Changes: 
Service Desk 5.10 Patch 9 

This section describes important behavior changes since Service Desk 5.10 Patch 9. 

QXCR1000325727: 
Faulty Form for Address Domain, Node and others are in Quick Find. 

Behavior change:  

User will be unable to click the select field button if the menu is empty. 

QXCR1000354556: 
Summary field of Schedule entity does not store the value entered. 

Behavior change:  

Summary field of Schedule entity will summarize the general information of the Schedule entity 
automatically and will be read only just like Schedule Element. 

QXCR1000803583: 
Attributes embedded into email body of DB Rule do not support nested brackets. 

Behavior change:  

The embedded attributes in DB Rule Action parameters now support nested brackets. 

QXCR1000813288: 
Upgrade failed on HPOvSlmMo after updating system role in SLM account 

Behavior change:  

The SLM Core account will be read only as of Service Desk 5.10 Patch 9. 

Fixes: 
Service Desk 5.10 Patch 8  

This section describes defects fixed by Service Desk 5.10 Patch 8. 

Defect Description 

QXCR1000390643 Parent category can be deleted, but its child cannot be deleted. 

QXCR1000451548 Deleting Language Pack causes data corruption. 

QXCR1000462126 Service Call: Quick Find is affected by Query Restriction. 

QXCR1000472174 DataCollector emits TriggerCaculationDatapoint with incorrect timestamps. 

QXCR1000748741 Service hours datapoints are discarded in the staging process of DataFeeder. 

QXCR1000754114 Typing the wrong user in Approver of a Change freezes the client with a 
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Defect Description 

Validation error. 

QXCR1000754666 View format Rules are not working. 

QXCR1000759155 Chart views based on Boolean attribute generates an error. 

QXCR1000761035 ovsdslm process aborts when [Infrastructure Availability] metric is removed. 

QXCR1000761070 Wrong SQL of querying datapoints from SQLQueue in DataFeeder. 

QXCR1000768805 Web API issue in multiple-server environment. Get data call uses an invalid 
session. 

QXCR1000771700 Destroy timer queue explicitly when time calculation is completed. 

QXCR1000782639 SLM emits incorrect order datapoints to OVPI during startup. 

QXCR1000782643 Ovsn MA does not close the socket after the discovery task is finished. 

QXCR1000782692 ServiceEngineTimeout of OvsnMA connector is hard-coded. 

QXCR1000783172 SLAs periods (monthly) do not change after the new period starts. 

QXCR1000786787 MA is treated as down when it is not down. 

QXCR1000803089 Font size in forms shrunk after update to Patch 6. 

Fixes: 
Service Desk 5.10 Patch 7  

This section describes defects fixed by Service Desk 5.10 Patch 7. 

Defect Description 

QXCR1000356753 Attachment: All Access cannot use classifications created by the system account. 

QXCR1000361801 Query takes an unexpectedly long time. 

QXCR1000363477 Classification checklist does not get focus when started in the service call screen. 

QXCR1000388428 Performance problem when updating a Child Organization. 

QXCR1000429624 Problem creating an Incident from Service Call because of field length mismatch. 

QXCR1000439748 Time of running the Service Desk client is not synchronized with the server 
dynamically. 

QXCR1000440223 Cannot add a Database Account with an empty Account Name. 

QXCR1000440894 Actual Duration field is not updated when using DB rules with related items. 

QXCR1000441191 Actions for Viewing the OVPI Reports are not visible within the full client. 

QXCR1000451945 Item in workflow does not open with the following fields are required 
message. 

QXCR1000452453 Multiple read-only notification popups are displayed if multiple roles are assigned. 

QXCR1000452498 Active sessions of web console users get multiplicity. 

QXCR1000459367 SD: Configuration Exchange - Import exchange file with overwrite option. 

QXCR1000461105 Attachment exist flag copied when using action Create Workorder from Incident. 

QXCR1000461618 Session are removed, but users cannot log on. 

QXCR1000461619 Customizing the current user view does not work. 
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Defect Description 

QXCR1000462518 OvObsLoadObject generates an Attempt to set value of readonly attribute 
warning. 

QXCR1000463050 Web console Java exception: relating new work order from service call. 

QXCR1000463068 Warning message box popup says Error when open service definition from 
another.... 

QXCR1000465328 Bad performance when listing services based on location search in a service call. 

QXCR1000467019 Service Quick Find in Advanced Find returns NullPointerException. 

QXCR1000467023 Change number custom field 123% issue. 

QXCR1000468478 Partly implements RFC2183 to make SD work with MS Exchange Server 2007. 

QXCR1000471194 Long child code table issue. 

QXCR1000471664 Relating Schedules to a Service Level does not work. 

QXCR1000472083 Required fields Notification Messages not working as expected. 

QXCR1000472593 Exception: Unexpected error when deserializing a JavaObject found in log file. 

QXCR1000713024 Columns contents missing when exporting a view. 

QXCR1000713541 Approval mail-notifications are not resolved for respective fields. 

QXCR1000740874 Cannot copy/paste records Hosted at from an Organization record. 

QXCR1000742010 After logging on to Web UI and ovconsole with the same account, the user 
privileges are different. 

QXCR1000748266 The number for maximum installations cannot be lower than.... 

QXCR1000758909 Old attachment cannot be opened after an upgrade to SD 5.1 Patch 4. 

QXCR1000764125 Time Cost calculation fields do not display the correct value. 

QXCR1000768834 Service Definition Check Cycle function is not completed. 

Important Behavior Changes: 
Service Desk 5.10 Patch 7 

This section describes important behavior changes since Service Desk 5.10 Patch 7. 

QXCR1000429624: 
Problem Creating an Incident from a Service Call Because of Field Length Mismatch 

Behavior change:  

When creating an incident from a service call, Service Desk truncates the text if it exceeds the maximum 
length of the target field. 

QXCR1000439748: 
Time of Running the Service Desk Client is Not Synchronized With the Server Dynamically 

Behavior change:  

The Service Desk 5.10 client synchronizes its time with that of the server dynamically.  
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QXCR1000471664: 
Relating Schedules to a Service Level Does Not Work 

Behavior change:  

In Service Desk 5.10 Patch 6 and earlier, one service level can be related to multiple schedules. As of Service 
Desk 5.10 Patch 7, only one service level can be related to one schedule.    

Fixes: 
Service Desk 5.10 Patch 6  

This section describes defects fixed by Service Desk 5.10 Patch 6. 

Defect Description 

QXCR1000303808 Assignment loop created when a Person is in two Workgroups. 

QXCR1000344769 Index out-of-bounds error when clicking a chart view legend. 

QXCR1000348759 Unable to delete a Person who created a new code as admin. 

QXCR1000349922 From the Person form, users can see CIs assigned to folders to which they have no 
access.  

QXCR1000354578 Cannot map the gender of a person to the value map “Unspecified.” 

QXCR1000360138 ON operator is not working in Advanced Find. 

QXCR1000361352 Date-time display format set in an account has no effect on custom date fields. 

QXCR1000362436 Cannot use IScheduledRuleTask in the Web API. 

QXCR1000394183 Better message is needed when running out of licenses. 

QXCR1000399198 java.lang.RuntimeException using the Web API for Approval. 

QXCR1000418901 Named Filter does not work as expected when relating objects in 5.1. 

QXCR1000431401 Audit History Line Deletions does not work. 

QXCR1000431406 Configuration Exchange log cannot be opened on the Solaris platform. 

QXCR1000432424 Right-clicking the blue bar in the Gantt view pops up an unexpected exception 
error. 

QXCR1000432455 Cannot save the modified format rule name for the table view for the system user. 

QXCR1000432872 System popup java.lang.ArrayIndexOutBoundException:2 results when the Y-Axis 
and Data....  

QXCR1000434415 “Hide” rights to “attachments” of a Service Call does not work. 

QXCR1000436508 Service field filled by “service supporting the CI” cannot be saved in SC. 

QXCR1000447711 Command cd - is not available on the Solaris platform. 

QXCR1000451656 ovloginsv status becomes N/A, and users are not able to log on to Service Desk  5.x. 

QXCR1000451968 No notification of query restricted if records are filtered after a query is restricted. 

QXCR1000452939 Data Update fails for related work orders if the predecessor ID is higher than.... 

QXCR1000459963 Operations >=1 years, >=2 years, and >=6 months do not work in the Format 
Rule.... 

QXCR1000463095 Outbound email To: <email addresses> line may exceed 1,000 characters. 
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Defect Description 

QXCR1000465774 Launch throws an exception when performing a class load. 

QXCR1000468883 Tomcat is out of memory after running for some time. 

QXCR1000471649 DB rule external actions fail with a Too many open files error. 

QXCR1000716752 Web Start digital signature error when launching Web Start. 

QXCR1000739024 When opening a related item from the hosted item, some field content in the 
related item.... 

QXCR1000739029 Cannot close the related item form again unless the main window is closed. 

QXCR1000739954 When opening a related schedule from a workgroup, the schedule element is lost. 

QXCR1000739960 UK DST reverts to GMT at 1 a.m. rather than at 2 a.m. 

QXCR1000740910 Customer fields do not take effect immediately. 

QXCR1000764580 Java XPL logging of different processes is spread over multiple files. 

QXCR1000764605 Default installation data folder changed on the Windows platform. 

QXCR1000469010 Object Server hangs in cache updating 

Important Behavior Changes: 
Service Desk 5.10 Patch 6  

This section describes important behavior changes since Service Desk 5.10 Patch 6. 

QXCR1000764580: 
Java XPL Logging of Different Processes is Spread Over Multiple Files  

Behavior change:  

Before Service Desk 5.10 Patch 6, all processes generated their own log files. Patch 6 changes this behavior. 
Now, all processes write to the same log file: system.0.en_US.  

QXCR1000764605: 
Default Installation Data Folder Has Changed on Windows  

Behavior change: 

Before Service Desk 5.10 Patch 6, the default installation data directory was the following: 

C:\Program Files\HP OpenView\data 

Now, the default installation data directory is the following: 

C:\Documents and Settings\All Users\Application Data\HP\HP BTO Software  

QXCR1000394183: 
Better Message is Needed When Running Out of Licenses 

Behavior change: 

Before Service Desk 5.10 Patch 6, when the number of users exceeded the number of licenses, the following 
error message popped up: 
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Login failed. You do not have access permissions. Please contact your system 
administrator. 

Now, the following error message pops up: 

Maximum X concurrent users can login at one time. 

Here, X represents the maximum number of users that can be logged on concurrently.  

Fixes: 
Service Desk 5.10 Patch 5  

This section describes defects fixed by Service Desk 5.10 Patch 5. 

Defect Description 

QXCR1000304724 Running ovobsconfig/modim -import should log a warning. 

QXCR1000306778 Groups by a field in views can result in duplicate groups. 

QXCR1000340665 Sorting on Columns does not work if some rows have empty data. 

QXCR1000342882 Information from the Parent attribute is not resolved in a DB rule. 

QXCR1000343653 NullPointerException after creating a form with the same name as an existing 
form. 

QXCR1000344105 Caller location not available for selection in a service call rule. 

QXCR1000352382 Auto format Rules do not work for “Deadline.” 

QXCR1000371685 Assigning the template to an SP user results in a Query Builder error. 

QXCR1000377237 Home of Person buttons in the Residential location opens the wrong forms. 

QXCR1000382985 Incident history line Edit button is presented when an account does not have 
Modify.... 

QXCR1000391562 File → Export → UI rule hangs. 

QXCR1000408642 Up/Down buttons clear the information field. 

QXCR1000408643 Deadline in the view format rule generates the java error 
java.lang.ClassCastException.... 

QXCR1000408690 Web console: Tree view is not displayed. 

QXCR1000410956 java.lang.NullPointerException occurs somehow. 

QXCR1000411995 Cannot sort rules manually. 

QXCR1000413981 Advanced Find label is not consistent. 

QXCR1000415850 History lines are not being updated. 

QXCR1000418411 Service Desk 5.1 SP1 Attachments sent on notification messages. 

QXCR1000418897 OvObsLoadObject.bat problems. 

QXCR1000419356 New UI Rules with duplicate ordering number. 

QXCR1000424098 Cannot copy UI rules. 

QXCR1000427952 Cannot edit the configuration item created by an incident template. 

QXCR1000431382 Multiple sessions after the console is reconnected. 



 41 

Defect Description 

QXCR1000431417 Status indicator shows a red X after the console is reconnected. 

QXCR1000432451 Improve the WAN performance issue of QXCR1000359551. 

QXCR1000434901 Cannot use Service Desk Web Start after installing JRE 1.6. 

QXCR1000436132 Change the content of the security warning dialog. 

QXCR1000438951 Recurring java.lang.NullPointerException when logging on to the web console. 

QXCR1000439762 New calls are attached with the attachments from old calls. 

QXCR1000450560 Object Server hangs because of the deadlock between RepositoryCollection and 
WeakR.... 

QXCR1000442684 Receive duplicate email notifications when an Item is assigned. 

QXCR1000445643 Unable to open attachments. 

QXCR1000448533 FTP failure causes Service Desk client to gray screen no error when opening 
attachments. 

Important Behavior Changes: 
Service Desk 5.10 Patch 5  

This section describes important behavior changes since Service Desk 5.10 Patch 5. 

QXCR1000371685: 
Assigning the Template to an SP User Results in a Query Builder Error 

Behavior change:  

When opening a new entity form, you are not allowed to use a different entity’s templates, only its super 
entity’s templates (if the super entity template exists). Before Service Desk 5.10 Patch 5, you could use a 
different entity’s templates, but an error resulted. 

Fixes: 
Service Desk 5.10 Patch 4  

This section describes defects fixed by Service Desk 5.10 Patch 4. 

Defect Description 

QXCR1000398937 Calls with folder rights do not show in Service Today. 

QXCR1000331302 Email notification to all members of a workgroup is not possible. 

QXCR1000337260 OVO/U Integration: monthly scheduled outage is not working. 

QXCR1000353298 Approved Change is still shown as My Approvals in Service Today. 

QXCR1000366497 Sending approval mail does not work in Service Desk 5.1. 

QXCR1000369341 Event queue reader thread stops after a Smart Action is created. 

QXCR1000369526 Associations check results in errors. 

QXCR1000378159 Related CIs cannot be inserted according to the template. 

QXCR1000378210 Service call accessing error by servicepage end user when it contains an SLA. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=882172&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=882736&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=905334&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=905642&template=view&tableid=1003
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Defect Description 

QXCR1000381729 WebUI: Exception thrown when there is an action email message to this person. 

QXCR1000385047 Category search criteria is cleared but still visible. 

QXCR1000387708 Field Subject in History Line is not filled in automatically. 

QXCR1000388496 Upgrade fails on loginname unique index creation after upgrading to SD 5.1 Patch. 

QXCR1000389407 The order of historyline displays incorrectly when registration time is very close. 

QXCR1000394861 Incorrect warning message popup when selecting a default form. 

QXCR1000396000 Text entered in Zoom field is not saved. 

QXCR1000396413 OVSD integration does not work with OVO/U agent core patch 8.16. 

QXCR1000397339 Custom fields are not refreshed when using arrows to navigate in forms. 

QXCR1000397749 Upgrade:Relation information cannot be displayed when you click the Preview button. 

QXCR1000398165 After an upgrade, services in the Service CI map view show OIDs if applying a filter. 

QXCR1000398895 Opening the first call of the view that only the view authorizes results in an exception. 

QXCR1000398954 SD 5.1 Patch1 scheduled task sends an email even when the condition is not met. 

QXCR1000399935 Failure when using scrolling up and down arrows in role editing. 

QXCR1000400275 Installing OVIS over OVSD 5.1 fails. 

QXCR1000402293 Not possible to sort fields when re-editing the actions of DB (UI) rules. 

QXCR1000403120 Service call Quick View is disabled in a related work order. 

QXCR1000403151 [Approval;Approval Votes;Approver;Primary E-Mail Address] mail send fails. 

QXCR1000403216 Problem exporting a view to a file. 

QXCR1000408182 View Format does not take effect with the set field [Open Duration] in Format Rules. 

QXCR1000410121 Obs monitor is not workable after opening for one day during endurance testing. 

QXCR1000410151 Upgrade installation from SD 5.1 to a new build failed on an HP-UX 23 machine.... 

QXCR1000411550 Client cache is forced to refesh when the client logon with non-classic approval.... 

QXCR1000411999 NullPointer exception in Object Server causes an error in the web GUI. 

QXCR1000413386 Error message pops up when triggering a Smart Action in a UI rule in the web console. 

QXCR1000414010 The OvObsModex command does not work with the -q parameter. 

QXCR1000414018 The search code is not correct when creating ci with the Generate CI Wizard. 

QXCR1000414493 The operating management service can be related to multiple SLAs. 

QXCR1000414506 WebUI: When deleting the default service level, the information that pops up is.... 

QXCR1000415589 Problem with the Service Event Relation View. 

QXCR1000418480 Import Person related to Organization is slow (bad performance). 

QXCR1000420461 UI and DB rules execution sequence. 

QXCR1000421856 OutOfMemoryError occurs after the Object Server is running for some time. 

QXCR1000422738 It is possible to create a work order predecessor-successor loop relationship. 

QXCR1000426108 SD 5.10 SP1 Service Pages Restricted and Full list takes 10 minutes. 

QXCR1000427087 Clients hang, and new clients are unable to connect. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=920894&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=949887&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=953462&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=959508&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=961409&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=968201&template=view&tableid=1003
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Defect Description 

QXCR1000427903 Too many missed scheduled tasks building up in the queue. 

QXCR1000427993 Sometimes, installing SD 5.10p2 fails in combination with SQL Server 2005. 

QXCR1000429248 Error message pops up when triggering a system action by using a UI rule in the web GUI.

QXCR1000430536 Service-CI map view pops up one error when it has filter conditions. 

QXCR1000430575 Create person pop-up error when setting field title or suffix in a person form.... 

QXCR1000430967 When adding an attachment in the web console, Tomcat process CPU spikes to 100%. 

QXCR1000433209 Unable to update using Planned Values. 

QXCR1000434128 Analyzed Data calculateReports defect. 

QXCR1000434864 OvObsLoadObject incorrect not a valid classname warning. 

QXCR1000434916 Object Server hangs when getting system environment variables. 

QXCR1000436521 Database Connection is not released immediately when sending an online message. 

QXCR1000441479 Populating Caller in a new Service Call takes too long under certain conditions. 

Fixes: 
Service Desk 5.10 Patch 3  

This section describes defects fixed by Service Desk 5.10 Patch 3. 

Defect Description 

QXCR1000333036 Secondary server connection is not found. 

QXCR1000385889 Primary grayed-out telephone/email fields are not updated after Data Exchange. 

QXCR1000375958 Related CI auditing shows OIDs instead of names and type in the history. 

QXCR1000361338 Incident Services filter does not work in view 

QXCR1000366066 Upgrade process fails for package HPOvObsSv-01.00.564-WinNT4.0-release.msi. 

QXCR1000381423 R:Fail to start autopass when checking Ignore client setting. 

QXCR1000384927 Search for “caller location” in Service Calls in the web console goes into a loop. 

QXCR1000385897 The reset password does not work in Service Desk 5.1. 

QXCR1000387392 Module error when opening attachments in the web console. 

QXCR1000348546 To Deadline in system view generates a “condition attribute is computed” error. 

QXCR1000366078 Generate CI wizard ends with an error. 

QXCR1000366889 Advanced Find on 64K text custom field fails when searching for one word. 

QXCR1000369834 Advanced Find View Filter does not work with CI. Used by Items is empty. 

QXCR1000370631 It is possible to create more than one relation between CIs of the same type. 

QXCR1000372770 Error message when adding Status (Service Today) to Service Event Relation. 

QXCR1000375636 Default incident status in SD causes errors if the user has no right to status. 

QXCR1000376924 Cannot select Business Location if there is no access role on Residential location. 

QXCR1000378873 SD 5.0 SP2 variable $HH$ always returns GMT time. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=793341&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=922947&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=899677&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=863582&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=875227&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=829864&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=875235&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=876628&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=883388&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=885787&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=891022&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=898229&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=901795&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=906630&template=view&tableid=1003
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Defect Description 

QXCR1000381351 Blocked checklist is still available in the GUI. 

QXCR1000389500 Error when submitting SC in SP if logged on with an SP account. 

QXCR1000309062 Wrong content for Role in help about the general user role. 

QXCR1000322829 Time duration is not displayed in the web console. 

QXCR1000377214 When sizing columns in group views, collapsed rows reopen automatically. 

QXCR1000377853 Filter in view from 5.0 to 5.1 no longer has the same attributes. 

QXCR1000354857 Licensing reconciliation with AutoPass slows down logons. 

QXCR1000331584 HP-UX scripts do not work because of a Ctrl-M at the end of every line. 

QXCR1000317617 Database Export/Import is possible using OvObsConfig. Is this supported? 

QXCR1000350494 Cannot resolve [Service call;Assignment;To Person;Primary E-Mail 
Address] in WO. 

QXCR1000347979 HTTP server used for UI/DB rules returned with error: 100 Continue. 

QXCR1000344803 Persons and roles indices are missing. 

QXCR1000344158 During an upgrade, customer settings are reset. 

QXCR1000342232 $ACCOUNTNAME$ system variable refers to the wrong attribute. 

QXCR1000341843 Sent Date is incorrect in outbound email. 

QXCR1000341262 Setting Caller using a searchcode that starts with a number fails. 

QXCR1000333897 Setting Assignment; to Workgroup using data update from an external system 
action. 

QXCR1000330984 Object Server stops/aborts without errors in the log files. 

QXCR1000325765 Copy/paste in rules results in records with a duplicate ordering number. 

QXCR1000317950 Cannot use %line.separator% in Database rules. 

QXCR1000388989 OVSD Metric Values value shows 0.0 when no records are evaluated. 

QXCR1000394464 Required fields are missing in Java Web Start. 

QXCR1000392163 QXCR1000366385 is not completely fixed. 

QXCR1000359551 Unacceptable performance when looking for services. 

QXCR1000379598 Removing Organization data results in an error on the template. 

QXCR1000362782 OVSD Metric negative indication is shown for a Service Call closed within the 
deadline. 

QXCR1000374159 Copying and pasting roles does not work. 

QXCR1000398507 java.lang.nullpointer when using Data Exchange with an external system 
UI rule. 

QXCR1000406017 Sessions are not removed from logged-on users after session timeout. 

QXCR1000345923 No way to map the account field in an account - role mapping with Data Exchange. 

QXCR1000381335 WebAPI setCreated() method should not be opened in javadocs. 

QXCR1000394452 Secondary server is not found in an AD environment. 

QXCR1000385900 java.lang.NullPointerException when defining limit field value rule. 

QXCR1000344669 Error in Audit relation for items. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=913209&template=view&tableid=1003
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Defect Description 

QXCR1000338157 Cannot set assignment to person or workgroup with Data Exchange db rule action. 

QXCR1000323433 Sort is not working with refresh in CardView. 

QXCR1000376331 The row redirects when Ctrl + Letter shortcut key is clicked. 

QXCR1000362503 AppLookupField causes performance problems. 

QXCR1000376666 Parent name cannot be updated in the child node if the parent node is modified. 

QXCR1000377492 Cannot create a form in a role. 

QXCR1000336941 Session disconnect closes the callback port. 

QXCR1000341765 Interactive logon failed. 

QXCR1000321386 Database Export/Import possible using OvObsConfig, but is not supported. 

QXCR1000332081 ACES run-time messaging import problem. 

QXCR1000403255 Incorrect transaction handling in sequencer causes database (MS-SQL) deadlocks. 

QXCR1000396042 Modify OvSdLic to make it accept command-line arguments. 

QXCR1000402679 Roles are not sorted in sub-branches. 

QXCR1000389404 Time is incorrect in PST time zone in Service Pages. 

QXCR1000286466 UI rules are executed in the background. 

QXCR1000405657 Database upgrade fail because of OutOfMemory issue 

Fixes: 
Service Desk 5.10 Patch 2  

This section describes defects fixed by Service Desk 5.10 Patch 2. 

Defect Description 

QXCR1000028515 ICE browser out-of-memory error displaying a TIP graph. 

QXCR1000036589 ICE nullpointer exception if TIPs form is closed before pages load. 

QXCR1000291081 Underpined-Operational Service: Exception in SD business logic. 

QXCR1000299650 Error logged when importing ACES file into OVSD. 

QXCR1000313676 OvObsModim and OvObsConfig core dump JVM. 

QXCR1000313889 SHOW fields in Service Desk 5.0. 

QXCR1000321016 OVConsoleCmd in smart action cannot use quotes in smart action parameters. 

QXCR1000321127 Obs: Config Exchange UI items are not fully populated. 

QXCR1000325476 Fields missing in DB Rule action to configure an update of related service events. 

QXCR1000327437 SD 5.0: Custom code fields of Service Level are not functioning correctly. 

QXCR1000330161 Relating several items in one action by drag and drop is not possible. 

QXCR1000332080 CME 3.1: Problems with Caliber 49052 ACES Runtime Messaging. 

QXCR1000332719 GUI 03.00.042: R: NullPointerException when selecting Load Template. 

QXCR1000333606 Code fields not sent in Data Exchange with External System Database Rule action. 
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Defect Description 

QXCR1000337168 Smart actions cannot access Computed Field as an attribute. 

QXCR1000341812 StackOverflowError when using Data Exchange with an external system. 

QXCR1000347192 No way to refresh the Combination view. 

QXCR1000347528 License consumption calculation does not always work correctly. 

QXCR1000348467 O:Approval description is not sent in the approval notification email. 

QXCR1000348778 Assigning roles or including roles is time-consuming. 

QXCR1000350209 Operator in the rule condition shows (OR) even if (AND) is chosen. 

QXCR1000359564 Data Exchange Task from the GUI on UNIX fails. 

QXCR1000361687 SD 5.1 offers fewer related items to choose from in the dbrule update data action. 

QXCR1000362363 Viewing the log file from the GUI after running Configuration Exchange fails. 

QXCR1000365040 In Data Exchange, there is an error when opening the config file. File not found. 

QXCR1000369304 Times displayed in Service Pages are wrong. 

QXCR1000373510 ObjectLoader handles the wrong username/password incorrectly. 

QXCR1000374142 Command bar customizer is not translated into Japanese. 

QXCR1000376901 Application for ovconsolecmd.bat generates an error. 

QXCR1000377285 Upgrade to SD 5.1 Patch 1 sometimes fails with Microsoft SQL Server 2000. 

QXCR1000378179 One hour is lost if the duration spans the DST change. 

QXCR1000379214 Application running on an older JRE 1.4 reports the incorrect time. 

QXCR1000380025 Java NullPointerException creates a subcontract service call. 

QXCR1000380416 OvObsLoadObject returns the wrong exit code, and writes in the wrong log file. 

QXCR1000380761 Console crashes after setting up a read-only rule that uses a CI category. 

QXCR1000380994 O:R:B:004 error message appears when executing OvObsLoadObject. 

QXCR1000381089 ovconsolecmd: no list of callers in case the criterion returns multiple values. 

QXCR1000381810 Approval vote windows generates nullpointer, and does not close on OK. 

QXCR1000382078 R:Error message of LoadObject is not intact. 

QXCR1000382977 Paste functionality with the mouse not available on objects. 

QXCR1000392344 Chart Views gives ClassCastException. 

QXCR1000322216 Smart Actions cannot access computed fields. 

QXCR1000315745 Out of Memory: ACES groups. 

Fixes: 
Service Desk 5.10 Patch 1  

This section describes defects fixed by Service Desk 5.10 Patch 1. 

Defect Description 

QXCR1000312768 Status value in Service Pages is not the template value. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=894778&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=738266&template=view&tableid=1003
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Defect Description 

QXCR1000313114 The AltGr key removes the focus from the text field to the menu. 

QXCR1000313147 Configuration Item map shows all related CIs. 

QXCR1000315198 No permissions to log on to the module Object ServerModule. 

QXCR1000319825 Cannot add more than 49 minutes in a scheduled condition. 

QXCR1000320438 Attributes disappear from the list when a two-part attribute is made a required field. 

QXCR1000320711 Ovconsolecmd is missing the -ListAlways command. 

QXCR1000324506 Boolean field of the type button does not display correctly. 

QXCR1000324920 Carriage returns in the “zoom in” window for a UI rule are not recognized by SD 5.0. 

QXCR1000327058 Field Approval Group does not work in the db-rule. 

QXCR1000327437 SD 5.0: Custom code fields of Service Level do not function correctly. 

QXCR1000330128 Item rights are not given when the folder is not defined in the form. 

QXCR1000333251 Exception is thrown when defining selection criteria in View Filter/Advanced Find. 

QXCR1000333667 OvSdLic.bat does not start. 

QXCR1000333950 Not possible to navigate in a view with the keyboard. 

QXCR1000335472 Issues with Advanced Find in SD 5.0: Cannot use wildcards in search code. 

QXCR1000340644 Boolean field of the button type does not work correctly when defined in a UI rule. 

QXCR1000340691 View for UI rules does not show conditions and actions. 

QXCR1000341188 UI rule Update Data Current Person Function does not work correctly. 

QXCR1000341901 When the Advanced Find dialog is closed, the launched form is also closed. 

QXCR1000342517 Custom field names with a period (.) cannot be used as parameters in rules. 

QXCR1000343719 New search does not clear the last used criterion in Advanced Find. 

QXCR1000344137 Time information on an axis of a chart view is shown as UTC time. 

QXCR1000344828 Search definition does not open because of IndexOutOfBoundsException. 

QXCR1000346192 Impact Priority mapping does not have an effect if there is no licenses for the SLM module. 

QXCR1000347852 O:Database errors returned when generating reporting views. 

QXCR1000348127 Password expiration does not work. 

QXCR1000348138 Graphic card problem with Service/CI Maps. 

QXCR1000348527 In Service Pages approvals, an exception without details is thrown. 

QXCR1000348542 Service Pages throws -java.lang.RuntimeException: Modification of attribute.

QXCR1000348782 Roles or include roles view is missing sorting capabilities. 

QXCR1000348784 UI rule and template fail to set approval data if the initiator <> is the current person. 

QXCR1000348900 Subject field in mail error template is not filled in properly. 

QXCR1000349054 Account templates are not available for creation or modification. 

QXCR1000349363 Standard Search Field names display incorrectly. 

QXCR1000349871 Unable to pass a parameter with spaces using a smart action. Quotes are replaced. 

QXCR1000349974 Template Name field in the toolbar is too short to show the full template name. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=739033&template=view&tableid=1003
http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=739071&template=view&tableid=1003
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http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=810843&template=view&tableid=1003
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Defect Description 

QXCR1000350166 View Action returned is not a result. 

QXCR1000350170 Users cannot sort Quick Find results by clicking a column header. 

QXCR1000350209 Operator-in-rule condition shows (OR) even if (AND) is chosen. 

QXCR1000352366 Templates for “role” and “roles per account” are not available for edit. 

QXCR1000352370 Format of SD 5.0 Views when printed is totally unacceptable. 

QXCR1000352388 Problems with logon and incoming mail to SD 5.x. 

QXCR1000353290 Unable to generate Service Calls using inbound emails. 

QXCR1000353595 Subentity cannot be added to a standard search. 

QXCR1000353928 Cannot resolve a 64K custom field in the body of an Incident email. 

QXCR1000353936 The Service Desk caller field is the same for a different (inbound) email sender. 

QXCR1000354913 How do you create an SC based on the Person phone number? 

QXCR1000354918 Problem with ovconsolecmd.bat when compared to sd_dataform. 

QXCR1000355596 Web console in SP1: stdout.log error message. 

QXCR1000355819 Automatically generated Email Rejection Notifications do not include the original email. 

QXCR1000356123 Attachments from old calls are attached to new calls. 

QXCR1000356282 Application Account Template is not visible in the template in SD 5.0 but available in SD. 

QXCR1000356305 Result of the action “Relate Impacted Services” is visible only after saving. 

QXCR1000357464 Relation Type menu is not populated in the web console. 

QXCR1000357855 Performance problem when creating a new Service Call in Service Pages. 

QXCR1000358149 License feature “SD Concurrent User” is not released after a session timeout. 

QXCR1000358441 Pop-up error message when parent and child CIs are both unique. 

QXCR1000360059 Cannot create a Configuration Exchange filter for Codes. 

QXCR1000360232 Disconnect of non-interactive session does not release license consumption until…. 

QXCR1000361295 Unable to get attribute mappings from SD import mapping using webapi. 

QXCR1000362032 Error message pops up when setting the Status for an icon attribute in the map view. 

QXCR1000362401 Send Email action lost from the db rule record after an upgrade from SD 5.0 + SP. 

QXCR1000363557 Error: You are not allowed to view this receiver organization.... 

QXCR1000363795 Default template for the role is ignored in the web console. 

QXCR1000363861 View→Edit→Format conditions: Last Week changes to Last Month. 

QXCR1000364119 Exception: Configure configuration item view, set filter in more TAB. 

QXCR1000364784 Parallel import does not work. 

QXCR1000365061 Drag-and-drop attachment does not work in SD 5.10, even when the attachment exists. 

QXCR1000366385 View-only access no longer works in SD 5.0 SP2. 

QXCR1000368932 Smart action for Outlook does not work. 

QXCR1000370936 One of the Approvers (exclude voted approvals) option in the filter is not available. 

QXCR1000372106 Q:Workorder permissions issue: inconsistent behavior. 
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Defect Description 

QXCR1000373490 Attachments and fields contents invisible when access rights are set to view-only 

QXCR1000372795 When closing an item, java.lang.ClassCastException is thrown.  

Fixes: 
Service Desk 5.10 

Service Desk 5.10 includes all customer fixes included in patches since Service Desk 5.0. 

http://teamtrack.hp.com/tmtrack/tmtrack.dll?IssuePage&recordid=892963&template=view&tableid=1003
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Known Problems, Limitations, and Workarounds 
This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch16 
(current release), Service Desk 5.10 Patch15 (previous release), Service Desk 5.10 Patch14, Service Desk 
5.10 Patch13, Service Desk 5.10 Patch 12, Service Desk 5.10 Patch 11, Service Desk 5.10 Patch 10, Service 
Desk 5.10 Patch 9, Service Desk 5.10 Patch 8, Service Desk 5.10 Patch 7, Service Desk 5.10 Patch 6, Service 
Desk 5.10 Patch 5, Service Desk 5.10 Patch 4, Service Desk 5.10 Patch 3, Service Desk 5.10 Patch 2, Service 
Desk 5.10 Patch 1, and Service Desk 5.10. 

General Problems: 
Service Desk 5.10 Patch 16 

There are no known problems in Service Desk 5.10 Patch 16.  

General Problems: 
Service Desk 5.10 Patch 15 

There are no known problems in Service Desk 5.10 Patch 15. 

General Problems: 
Service Desk 5.10 Patch 14 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 14. 

QXCR1000876251: 
Online Help for OvObsClientSettingsEditor is Not Localized into Korean 

Problem  

There are some exceptions printed in the command line window when launching OvObsClientSettingsEditor 
on an operating system with locale set to Korea and language set to Korean. 

How to reproduce: 

1 Install Service Desk 5.10 management server. 

2 Install Service Desk 5.10 language pack. 

3 Set the locale to Korea and the default language to Korean. 

4 Execute command OvObsClientSettingsEditor under <OvInstallDir>/bin. 

Expected Result 

The Online Help of client settings editor is displayed in Korean. 

Actual Result 

The Online Help of client settings editor is not displayed in Korean. 
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Solution 

None. 

Workaround 

1 Go to directory <OvInstallDir>\help\ko\ov_java\obs\ObsClientSettings, then open 
ObSClientSettings.hs file in a text editor. 

2 Modify the first line for the file. 

By default, it should be like following: 

 <?xml version='1.0' encoding='UTF-8' ?> 

Replace all single quotes with double quotes. After the change is done, the first line of the file should     
  look like the following: 

<?xml version="1.0" encoding="UTF-8" ?> 

QXCR1000876262: 
Online Help for OvObsServerSettingsEditor is Not Localized into Korean 

Problem  

There are some exceptions printed in the command line window when launching OvObsServerSettingsEditor 
on an operating system with locale set to Korea and language set to Korean. 

How to reproduce: 

1 Install Service Desk 5.10 management server. 

2 Install Service Desk 5.10 language pack. 

3 Set the locale to Korea and the default language to Korean. 

4 Execute command OvObsServerSettingsEditor under <OvInstallDir>/bin directory. 

Expected Result 

The Online Help of server settings editor is displayed in Korean. 

Actual Result 

The Online Help of server settings editor is not displayed in Korean. 

Solution 

None. 

Workaround 

1 Go to directory <OvInstallDir>\help\ko\ov_java\obs\ObsServerSettings and then open file 
ObSServerSettings.hs in a text editor. 

2 Modify the first line for the file. 

3 By default, it should be like following: 

<?xml version='1.0' encoding='UTF-8' ?> 

Replace all single quotes with double quotes. After the change is done, the first line of the file should 
look like the following: 
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<?xml version="1.0" encoding="UTF-8" ?> 

QXCR1001020530: 
The Data and Log Folder path information is not correct. 

Problem  

The Data and Log Folder path information is not correct if the default Data and Log Folder path was 
modified. 

How to reproduce: 

1 On Window 2008 machine, create two folders "HP SD Application" and "HP SD Data" under the C:\ 
directory. 

2 Install OVSD5.1 server with Oracle10g, select HP SD Application as Application Folder and HP SD 
Data as Data Folder. 

3 Login OvConsole with system account. 

4 Click Help → About to open the “About OpenView Console..." window, and go to the General tab. 

5 Review Client Log File path information [Result 1]. 

6 Review Client Data Folder path information [Result 2]. 

Expected Results: 

[Result 1]: The Log Folder: C:\HP SD Data\HP Openview\log\ui-console.log.0 
[Result 2]: The Data Folder: C:\ HP SD Data\HP Openview 

Actual Results: 

[Result 1]: The Log Folder: C:\Users\Admin\Application Data\HP Openview\log\ui-
console.log.0 
[Result 2]: The Data Folder: C:\Users\Admin\Application Data\HP OpenView 

NOTE: This is not a new defect on Windows 2008. It also exists on Windows 2003. 

Solution 

None. 

Workaround 

None. 

QXCR1000968260: 
Change name of OVSD Metric is not allowed 

Problem  

The information regarding what fields are editable for Service Desk Metrics is incorrect in the online help. 

How to reproduce: 

1 On an OV Console, go to Service Manager > OVSD Metric. 

2 Create a new OVSD Metric. Provide the required information, then save and close the form. 

3 Open the newly created OVSD Metric item. You can see that the Name field can not be changed. 
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4 Press F1 to launch the Online Help.  

5 On the right panel, click on the link Define Service Desk Metrics. 

6 The Define Service Desk Metrics page opens. Scroll down to the bottom of the page. In the last Note  
 section, it states: 

After you save a metric, you can change only these fields:  
Name  
Active 
Period 
 

When you create a metric, Active is automatically selected. The metric becomes active when the 
reporting period starts. 

 
The description in the Online Help does not correctly reflect the real state of the Name field on an  
OVSD Metric form. 

Solution 

None. 

Workaround 

None. 

General Problems: 
Service Desk 5.10 Patch 13 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 13. 

QXCR1000399203: 
(L10N) Error Messages Appear When Executing OvObsServerSettingEditor on Japanese 
Operating System 

Problem  

There are some exceptions printed in the command line window when launching OvObsServerSettingsEditor 
on an operating system with locale set to Japan and language set to Japanese. 

How to reproduce: 

1 Install Service Desk 5.10 management server. 

2 Install Service Desk 5.10 language pack. 

3 Set the locale to Japan and the default language to Japanese. 

4 Execute command OvObsServerSettingsEditor under <OvInstallDir>/bin. 

Expected Result 

ServerSettingsEditor opens without any error message. 
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Actual Result 

ServerSettingsEditor opens with error message appearing in Windows command line window or terminal 
window. The error message details are as follows: 

java.io.EOFException: no more data available 
at org.xmlpull.mxp1.MXParser.fillBuf(MXParser.java:2968) 
at org.xmlpull.mxp1.MXParser.more(MXParser.java:2975) 
at org.xmlpull.mxp1.MXParser.nextImpl(MXParser.java:1407) 
at org.xmlpull.mxp1.MXParser.next(MXParser.java:1137) 
at oracle.help.common.xml.HelpXmlPullParser._processDocument(Unknown Source) 
at oracle.help.common.xml.HelpXmlPullParser.<init>(Unknown Source) 
at oracle.help.common.xml.ParserFactory.createParser(Unknown Source) 
at oracle.help.library.helpset.XMLLinkParser.parseLinkFile(Unknown Source) 
at oracle.help.library.helpset.XMLLinkParser.parseLinkFile(Unknown Source) 
at oracle.help.library.helpset.HelpSet.getAssociativeLinks(Unknown Source) 
at oracle.help.common.AssociativeLinkRepository.addLinksInBook(Unknown Source) 
at oracle.help.library.Library.addBook(Unknown Source) 
at oracle.help.Help.addBook(Unknown Source) 
at oracle.help.CSHManager.addBook(Unknown Source) 
at com.hp.ov.obs.ui.PropertySheet.initializeHelpManager(PropertySheet.java:423) 
at com.hp.ov.obs.impl.ui.config.ServerSettingsEditor.initializeHelp(ServerSettingsEditor.java:98) 
at com.hp.ov.obs.impl.ui.config.ServerSettingsEditor.<init>(ServerSettingsEditor.java:88) 
at com.hp.ov.obs.impl.ui.config.ServerSettingsEditor.main(ServerSettingsEditor.java:1368) 
at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method) 
at sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.java:39) 
at sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:25) 
at java.lang.reflect.Method.invoke(Method.java:324) 
at com.hp.ov.obs.startup.AbstractLauncher.invokeNormal(AbstractLauncher.java:146) 
at com.hp.ov.obs.startup.Launcher.invoke(Launcher.java:176) 
at com.hp.ov.obs.startup.Launcher.main(Launcher.java:142) 
at com.hp.ov.obs.startup.Launcher.main(Launcher.java:61) 

NOTE: The defect exists with Japanese language on all platforms. 

Solution 

None. 

Workaround 

Edit <OvInstallDir>\help\ja\ov_java\obs\ObsServerSettings\ObSServerSettingsLINK.xml 
by appending </link> to the bottom of the file. After modification, the content of the file should look like 
the following: 

<?xml version="1.0" encoding="UTF-8"?> 
<link version="1.0"> 
</link> 

General Problems: 
Service Desk 5.10 Patch 12 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 12. 
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QXCR1000815938: 
Audit of History Lines Does Not Work 

Problem  

When a user modifies an existing history line, the change is not reflected in the relevant message in the 
History tab, even if an audit of history lines was enabled. 

How to reproduce: 

1 Click OV Configuration→Users & Security→Audit→Audit Rules→Service Calls. 

2 Select the Solution and History Lines attributes for auditing. 

3 Create a new Service call: 

a In the Solution field, type Test. 

 In the History tab, a new string is added indicating that the solution is set to Test. 

b Save the service call. 

c In the Solution field, add a string (for example, test 123).  

 The new string is added to the History tab, with the message solution from Test to test 123. 

4 Repeat the previous step for history lines.  

  Create a new history line, and then try to modify it. You do not have to indicate what has changed in  
  the Subject or Information fields. 

Expected Result 

The modifications to history lines are reflected in the History tab. 

Actual Result 

The modifications to history lines are not reflected in the History tab. 

Solution 

None. 

Workaround 

None. 

QXCR1000927622: 
Primary Currency Sign is Not Displayed Correctly on HP-UX 11.23 

Problem  

In OvConsole on HP-UX 11.23, a corrupt currency sign displays instead of the predefined primary currency 
sign for the currency type of field. 

How to reproduce: 

1 Click OV Configuration→System Settings→Regional Settings→Currency, and then select Primary 
Currency Sign/Name. 
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2 Click Workspaces→Service Desk→Service Call, and then create new service call or open an existing 
service call. 

3 Click the Time/Cost tab, type 10000 in the Planned Cost or Actual Cost field, and then click another 
field. 

Expected Result 

The predefined primary currency sign displays. 

 

Actual Result 

A corrupt sign displays. 

Solution 

None. 

Workaround 

None. 

QXCR1000930511: 
Exception is Thrown When Creating Service Calls by Using Service Pages After an Upgrade 

Problem  

An exception is thrown when creating service calls by using Service Pages after an upgrade to Service Desk 
5.10 Patch 6. 

How to reproduce: 

1 Click Workspaces→Service Manager→Service, open ZI-Lab Email Service, and click the Compliance 
Status tab to make sure that there is a record in the “Status per sla” view. 

2 Click Workspaces→OV Configuration→Templates, and then navigate to the “Templates Object Type” 
view. 

3 Create a new template for the service call, set the value of the Service field to ZI-Lab Email Service 
as an Existing Value, and then save and close the template. 

4 Click Workspaces→OV Configuration→Actions & Rules, create a new UI Rule for Service Call with 
the condition Service;Name contains(AND) "ZI", give the rule an action, and save the rule. 

5 Click Workspaces→OV Configuration→Service Pages→Template Settings→Service Call, select the 
template created in the previous step as “Template for insert” for the Support Engineer and SP End 
User. 

6 Click Workspaces→OV Configuration→Service Pages→Access→Service Pages Account, and then 
create a new service page account. 

7 Log on to Service Pages with the service page account that you created in the previous step. 

8 Click the Create a new Service call link in the left navigation pane. 
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Expected Result 

The service call is created successfully. 

Actual Result 

Instead of a new service call being created, an error message displays on the web page: 

Error - an exception was thrown trying to create the service call. 

Exception - You are not allowed to view this service status. Check server log for details. 

In addition, the log file contains the following error message: 

com.hp.ov.obs.impl.apiserver.ApiServerEntity;openNew;com.hp.ov.obs;SEVERE;Error while 
performing webapi request: {0} 
com.hp.ov.obs.ApplicationException: You are not allowed to view this service status 
 at com.hp.ov.obs.impl.wf.AppEntityHome.checkViewAllowed(AppEntityHome.java:1637) 
 at com.hp.ov.obs.impl.wf.AppEntityHome.open(AppEntityHome.java:580) 
 at com.hp.ov.obs.impl.wf.AppAbstractEntitySet._open(AppAbstractEntitySet.java:1199) 
 at com.hp.ov.obs.impl.wf.AppAbstractEntitySet.open(AppAbstractEntitySet.java:1133) 
 at com.hp.ov.sd.slm.wf.biz.ServiceSlmExt.getLowestCompliance(ServiceSlmExt.java:266) 
 at com.hp.ov.sd.slm.wf.biz.ServiceSlmExt.access$2(ServiceSlmExt.java:254) 
 at com.hp.ov.sd.slm.wf.biz.ServiceSlmExt$4.get(ServiceSlmExt.java:229) 
 at com.hp.ov.obs.impl.wf.AppEntity.callSpecificGet(AppEntity.java:1855) 
 at com.hp.ov.obs.impl.wf.AppEntity.getValue(AppEntity.java:1812) 
 at com.hp.ov.obs.impl.wf.AppEntity.getValue(AppEntity.java:1771) 
 at com.hp.ov.obs.impl.wf.AppEntity.getAllValues(AppEntity.java:5597) 
 at com.hp.ov.obs.impl.wf.AppEntity.getAllValues(AppEntity.java:5583) 
 at com.hp.ov.obs.impl.apiserver.ApiServerEntity.openNew(ApiServerEntity.java:559) 
 at sun.reflect.NativeMethodAccessorImpl.invoke0(Native Method) 
 at sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.java:39) 
 at 
sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:25) 
 at java.lang.reflect.Method.invoke(Method.java:324) 
 at com.hp.ov.obs.impl.net.itp.AppItpRequest.localInvoke(AppItpRequest.java:276) 
 at 
com.hp.ov.obs.impl.net.itp.AppItpRequestHandler.process(AppItpRequestHandler.java:184) 
 at 
com.hp.ov.obs.impl.net.tcp.AppTcpConnection.processRequest(AppTcpConnection.java:684) 
 at com.hp.ov.obs.impl.net.tcp.AppTcpThread.run(AppTcpThread.java:155). 

Solution 

None. 

Workaround 

Create a new role with view access to the Service Status entity. Do not grant any views, forms, or 
workspaces to this role. Edit the built-in Service Pages Role to include the new role. 

QXCR1000950839: 
Java WebStart is Unable to Automatically Download JRE1.6_07 on Windows Vista 

Problem  

Java WebStart cannot automatically download the specified JRE version 1.6_07 on Microsoft Windows Vista. 

How to reproduce: 

1 Install Service Desk 5.10 Patch 12 on a Windows 2003 server named host1. 

2 On a Windows Vista machine, open a web browser and type the following location: 
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 http://host1[:port]/ovconsole 

3 Click the HP OpenView Console link to launch the WebStart client. 

Expected Result 

Java WebStart automatically downloads and installs JRE1.6_07. 

Actual Result 

Java Web Start is unable to automatically download and install the requested JRE version.  

Solution 

None. 

Workaround 

Install JRE1.6_07 on Microsoft Vista manually. 

General Problems: 
Service Desk 5.10 Patch 11 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 11. 

QXCR1000455906: 
Upgrade of the Secondary Server Re-enables the ovsdslm Process 

Problem  

1 No matter which primary or secondary server is used, when installing or upgrading an OVSD server, 
the following three services are installed by default: 

— ovsdslm 

— ovsdreport 

— ovslmdimexp 

2 However, these three services can be run only with one OVSD server in a production environment.  

3 For details, see the online help (Using Service Desk → Service Level Manager → SLM Administrations 
→ Start and Stop the SLM Server Process).  

Expected Result 

When installing or upgrading, the three services listed above are not installed on servers other than the 
primary server. 

Actual Result 

When installing or upgrading, the three services listed above are installed on servers other than the primary 
server. 

Solution 

None. 

http://localhost:8004/jnlp/ovconsole.jnlp
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Workaround 

After installing and upgrading, manually delete the three services from the OVSD servers that do not need 
them by entering the following commands: 

ovcreg -del ovsdslm 

ovcreg -del ovsdreport 

ovcreg -del ovslmdimexp 

General Problems: 
Service Desk 5.10 Patch 10 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 10. 

QXCR1000866986: 
Upgrade Does Not Remove the HP OpenView Console Local Hotfixes Automatically 

Problem  

Hotfixes installed on the client side are not cleaned out after an upgrade. 

How to reproduce: 

1 Install a Service Desk 5.10 Patch 9 application server. 

2 Install a Service Desk 5.10 Patch 9 client on a separate machine, named host1. 

3 Start the hotfix management tool, named hotfixshell. 

4 Apply a client hotfix, and enable the hotfix auto-update feature. 

5 On host1, start the HP OpenView console to install the new hotfix on the client side. 

6 Disable the hotfix auto-update feature through hotfixshell. 

7 On host1, upgrade the Service Desk 5.10 client to Patch 10.  

Expected Result 

Under the service desk user folder, the java directory should be removed. 

Actual Result 

Under the service desk user folder, the java/hotfix directory still exists with the hotfix file in it. 

Solution 

It is planned to fix this problem in a later patch. 

Workaround 

Disable the hotfix auto-update feature through hotfixshell, and then remove the existing client side hotfix 
manually from the java/hotfix directory. 
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QXCR1000868097: 
Pop-up Window Loses Focus 

Problem  

The pop-up window loses focus. 

How to reproduce: 

1 Run ovconsole. 

2 Select Work Spaces→Service Desk→Service Call. 

3 Select View→Show In New Window. 

Expected Result 

A new window pops up and shows on the top of other windows. 

Actual Result 

The pop-up window loses focus and is hidden behind the ovconsole window. 

Solution 

None. 

Workaround 

None. 

General Problems: 
Service Desk 5.10 Patch 9 

No known problems or limitations have been identified in this patch. 

General Problems: 
Service Desk 5.10 Patch 8 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 8. 

QXCR1000443048: 
Unable to Import a Custom Created Relation 

Problem  

Unable to successfully import records for a custom created relation. 

How to reproduce: 

1 Create two person records. 

2 Select HP OpenView Configuration→Data→Relations. 



 61 

3 Create a custom relation between two Person entities: 

Text: Person - Consultant 

From: Person 

To: Person 

This step enables you to register the relation between person A and person B.  

4 Select HP OpenView Configuration→Presentation→Forms. 

5 In the Person form, add the following attributes: 

— Referenced From 

— Referring To  

6 Select HP OpenView Configuration→Templates Object Type: Reference. 

7 Create a template: 

Name: Template Reference Person - Consultant 

Template value for Relation: Person - Consultant 

8 Select HP OpenView Configuration→Data→Data Exchange→Import Mapping. 

9 Create import mapping:  

Name: PERSONS 

Entity Mappings: 

Internal Entity: Reference 

Template: Template Reference Person - Consultant 

External Entity: REFERENCE 

Attribute Mapping: 

Internal Attribute: To 

Reference To: Entity.Refering To 

External Attribute: TO 

Used as primary key: (selected) 

Internal Attribute: From 

Reference To: Entity.Referenced From 

External Attribute: FROM 

Used as primary key: (selected) 

10 Select HP OpenView Configuration→Data→Data Exchange→Data Exchange Task. 

11 Create a Data Exchange Task:  

Exchange file: reference.xml 

Import: (selected) 

Account: system 

Import Mapping: PERSONS 

Debug: (selected) 

You need to change the values of the person names to the ones that you created in Step 1. 
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Expected Result 

Able to successfully import records for a custom created relation. 

Actual Result 

When running this task, the following error message is shown in the error log and the task fails: 

Unable to find mapping for TopEntity.Referenced From… 

General Problems: 
Service Desk 5.10 Patch 7 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 7. 

QXCR1000779672:  
SD5.10 Patch 6 Client and Agent Cannot be Installed on Microsoft Windows Vista  

Problem  

Service Desk 5.10 Patch 6 installation fails on Microsoft Windows Vista if Microsoft Visual C++ 2005 SP1 
Redistributable Package is not installed. 

How to reproduce: 

1 Download Service Desk 5.10 Patch 6. 

2 Start the installation of the Service Desk client or agent on a Microsoft Windows Vista platform that 
does not have Microsoft Visual C++ 2005 SP1 Redistributable Package installed. 

Installation fails when HPOvXpl component is being installed.  

3 Select OS System Event View→Windows Log→Application Item.  

The following error message can be found: 

"Activation context generation failed for "C:\Program Files\HP 
OpenView\bin\ovconfchg.exe". Dependent Assembly Microsoft.VC80.CRT, 
processorArchitecture="x86",publicKeyToken="1fc8b3b9a1e18e3b",type="win32",version="8.0.50
727.762" could not be found. Please use sxstrace.exe for detailed diagnosis" 

Expected Result 

Service Desk client and agent can be installed successfully on the Microsoft Windows Vista platform. 

Actual Result 

Service Desk client and agent installation fails when installing the HPOvXpl component.  

Workaround 

Install Microsoft Visual C++ 2005 SP1 Redistributable Package manually before installing Service Desk. 

You can download the package from the following Web site: 

http://www.microsoft.com/downloads/details.aspx?familyid=200B2FD9-AE1A-4A14-984D-
389C36F85647&displaylang=en 
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Solution 

Currently, the workaround is the solution for the problem. 

QXCR1000790895: 
Upgrade Process Cannot Clear Existing Hotfixes Automatically  

Problem  

Service Desk 5.10 Patch 5 introduced a new hotfix deployment mechanism, performed with a signed jar file 
in the <%OvInstallDir%>/java/hotfix folder. Service Desk 5.10 Patch 6 and higher are supposed to clear 
existing hotfixes, which were deployed with the new hotfix mechanism.  

Solution 

It is planned to fix this problem in a later patch. 

Workaround 

As a workaround, follow these steps: 

1 Enter the following: 

ovc –stop  

2 Enter the following: 

ovc –kill  

3 Remove all fies from the hotfix folder: 

— Windows 

<%OvInstallDir%>\java\hotfix   

— UNIX 

<$OvInstallDir>/java/hotfix   
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General Problems: 
Service Desk 5.10 Patch 6 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 6. 

QXCR1000748552: 
Uninstalling a Client on Microsoft Windows Vista Fails 

Problem  

Service Desk client cannot be uninstalled successfully on Microsoft Windows Vista.  

How to reproduce: 

1 Install the Service Desk 5.10 Patch 6 client on the Microsoft Windows Vista platform. 

2 Go to %OvInstallDir %/Uninstall/Client. 

3 Execute setup.exe. 

4 A warning dialog pops up during uninstallation.  

 
 

Solution 

This issue is planned to be fixed in Service Desk 5.10 Patch 7. 
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QXCR1000763030: 
Compiling ov-webapi-gen.jar Fails When Using the Default Data Folder on Windows 

Problem  

ov-webapi-gen.jar compilation fails when Service Desk is installed in the default data folder on Microsoft 
Windows.  

How to reproduce: 

1 Install Service Desk 5.10 Patch 6 with the Demo database, and use the default data folder. 

2 Install the Web API package. 

3 Run ovc -start to start all services. 

4 From %OvInstallDir%\bin, run OvObsWebAPIGenerator.bat. 

5 From %OvInstallDir%\examples\webapi\generation, copy the file build.xml. 

6 Go to the following directory: 

C:\Documents and Settings\All Users\Application Data\HP\HP BTO Software\web-api-
generated\ 

7 Run ant build. 

The build fails. 

Solution 

This problem is planned to be fixed in Service Desk 5.10 Patch 7. 

Workaround 

As a workaround, follow these steps: 

1 Go to %OvDataDir%\web-api-generated. 

2 Modify build.xml.  

Example: 

— Original build script  

<property name="xobs.java.dir" value="../../java" /> 

— Modified build script  

<property name="xobs.java.dir" value="C:/Program Files/HP OpenView/java" /> 

This example assumes %OvInstallDir% is C:/Program Files/HP OpenView/. 
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General Problems: 
Service Desk 5.10 Patch 5 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 5. 

QXCR1000465774: 
Log File Shows a Hotfix Error When Starting Up on Windows  

Problem  

When starting up the system on the Microsoft Windows platform, the log file shows the following message: 

An error occurred in the retrieving hotfix information 

Solution 

This problem will be fixed in Service Desk 5.10 Patch 6. 

Workaround 

In the <OvInstallDir>\java folder, create a hotfix folder. 

NOTE: The problem occurs only if no hotfix is installed. You can safely ignore it. The problem does not cause 
problems in Service Desk. Hotfix information is retrieved successfully if any hotfix is installed. 
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General Problems: 
Service Desk 5.10 Patch 4 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 4. 

QXCR1000353298: 
Approved Change is Still Shown as My Approvals in Service Today 

Problem  

When using the Your Approval Tasks view, duplicate rows are shown instead of different items if two or 
more tasks need approval. Even if you approve one of the tasks, the approval tasks view retains its original 
rows.  

Solution 

When using the Your Approval Tasks view, items can be shown correctly, but you need to check Your 
Approval Tasks manually. 

NOTE: Before Service Desk 5.10 Patch 3, in the Your Approval Tasks filter of Service Today, the option 
Where I am: one of the approvers and have not yet voted was selected by default. After you 
upgrade to Service Desk 5.10 Patch 4, the selected option is cleared. You need to select it manually.  
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General Problems: 
Service Desk 5.10 Patch 3 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 3. 

QXCR1000424590: 
Localization Characters Do Not Display Correctly after an Upgrade to SD 5.1 Patch 3 

Problem 

Service Desk 5.10 Patch 3 uses a new jar-signing algorithm (DSA) that is not compatible with the algorithm 
(RSA) used prior to the Service Desk 5.10 Patch 3 L10N package (Build 05.10.032)  

Solution 

Do not upgrade to Service Desk 5.10 Patch 3 if a L10N package (lower than Build 05.10.032) is installed 
until the release of the new localization package (Build 05.10.032). 

If you installed the localization package for Service Desk 5.10 Patch 2, wait for the release of the new 
localization package (Build 05.10.032) for Service Desk 5.10 Patch 3. After the release, install Service Desk 
5.10 Patch 3 and the related L10N package (Build 05.10.032). 

Workaround 

None. 

QXCR1000394116: 
Java Web Start Certificate Expiration Issue 

Problem 
A message with a “soon expired” and an “expired” certificate pops up when the console is started using Java 
Web Start.   

Solution 

This message can be ignored. It has no impact on any Service Desk functionality.   

Workaround 

None. 

QXCR1000414442: 
Java Web Start JRE Version is Not Consistent With the Normal Client 

Problem  

By default, Service Desk Java Web Start uses JRE 1.4.2_07. This version has a DST issue. OVSD is shipped 
with JRE1.4.2_11, but Sun’s automatic-download mechanism does not support versions higher than JRE 
1.4.2_07.  
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Solution 

None. 

Workaround 

Deinstall JRE 1.4.2_07, and then install JRE 1.4.2_11 manually.  

QXCR1000396413: 
OVSD Integration Does Not Work With OVO for UNIX Agent Core Patch 8.16 

Problem 
HP OpenView Operations for UNIX (OVO for UNIX) cannot be started after the Service Desk integration 
package is installed.   

Solution 

This problem will be fixed in Service Desk 5.10 Patch 4. 

Workaround 

To downgrade the XPL and Ctrl components to those used by the OVO agent patch, follow these steps: 

1 On the OVO management server, do one of the following:  

• HP-UX Itanium 

# cd /var/opt/OV/share/databases/OpC/mgd_node/vendor/hp/ipf32/hpux1122/A.08.10.160/RPC_BBC 

# cp HPOvCtrl.depot.Z /var/tmp 

# cp HPOvXpl.depot.Z /var/tmp 

# cd /var/tmp 

# uncompress HPOvCtrl.depot.Z 

# uncompress HPOvXpl.depot.Z 

# swinstall -x allow_downdate=true -s /var/tmp/HPOvXpl.depot HPOvLcore 

# swinstall -x allow_downdate=true -s /var/tmp/HPOvCtrl.depot HPOvLcore 

• HP-UX PA-RISC 
# cd /var/opt/OV/share/databases/OpC/mgd_node/vendor/hp/pa-risc/hpux1100/A.08.10.160/RPC_BBC 

# cp HPOvCtrl.depot.Z /var/tmp 

# cp HPOvXpl.depot.Z /var/tmp 

# cd /var/tmp 

# uncompress HPOvCtrl.depot.Z 

# uncompress HPOvXpl.depot.Z 

# swinstall -x allow_downdate=true -s /var/tmp/HPOvXpl.depot HPOvLcore 

# swinstall -x allow_downdate=true -s /var/tmp/HPOvCtrl.depot HPOvLcore 
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• Sun Solaris 
# cd /var/opt/OV/share/databases/OpC/mgd_node/vendor/sun/sparc/solaris7/A.08.10.160/RPC_BBC 

# cp HPOvCtrl.sparc.Z /var/tmp 

# cp HPOvXpl.sparc.Z /var/tmp 

# cd /var/tmp 

# uncompress HPOvCtrl.sparc.Z 

# uncompress HPOvXpl.sparc.Z 

# pkgrm HPOvXpl 

Answer all questions with “yes.” 
# pkgrm HPOvCtrl 

Answer all questions with “yes.” 

# pkgadd -d /var/tmp/HPOvXpl.sparc HPOvXpl 

Answer “Do you want to install conflicting files?” with “no.” 

Answer all other questions with “yes.” 

# pkgadd -d /var/tmp/HPOvCtrl.sparc HPOvCtrl 

Answer “Do you want to install conflicting files?” with “no.” 

Answer all other questions with “yes.” 

2 Start the opcsv processes, and verify that they are running: 

# opcsv –start 
# opcsv -status 

3 Start the ovc processes, and verify that they are running: 

# ovc –start 
# ovc –status 

4 Register and start the Object Server agent that is used by the Service Desk integration: 

# cd /var/opt/OV/conf/obs 
# ovcreg -add OvObsAg.xml 
# ovc ?start ovobsag 
# ovc –status 

The agent should now appear in the ovc processes list (ovobsag). 

5 Verify that all processes are running. 

If all processes are running, the OVO for UNIX management server, OVO for UNIX agent, and the 
Service Desk integration are available. 
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General Problems: 
Service Desk 5.10 Patch 2 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 2. 

QXCR1000396036: 
Agent Does Not Work on HP-UX 11.11 

Problem 
When upgrading to Service Desk 5.10 Patch 2 on HP-UX 11.11, the agent does not work well. 

Solution 

This problem will be fixed in Service Desk 5.10 Patch 3. 

Workaround 

Enter the following: 

#>chmod a+x /opt/OV/nonOV/jre/1.4/bin/HPUXChildWrapper 

How to verify: 

#>ls –l /opt/OV/nonOV/jre/1.4/bin/HPUXChildWrapper 

Expected result: 

-r-xr-xr-x   1 bin bin 24576 Nov 15 2005 /opt/OV/nonOV/jre/1.4/bin/HPUXChildWrapper 

QXCR1000399579: 
Upgrade to Service Desk 5.1 Patch 2 or Higher if TZupdater (SDSK_00107) was Applied  

Problem  

If SDSK_00107 was applied to solve the US DST change issue, upgrade to Service Desk 5.10 Patch 2 or 
higher. The information may be different from that when upgrading without SDSK_00107. 

Solution 

None. 

Workaround 

As a workaround, remove all files and subdirectories in the following directories: 

Windows 

<OvInstallDir>\nonOV\jre\1.4\lib\zi 

<OvInstallDir>\nonOV\jdk\a\jre\lib\zi 

UNIX 

/opt/OV/nonOV/jre/1.4/lib/zi 

/opt/OV/nonOV/jdk/a/jre/lib/zi 

Keep the zi directory. 
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QXCR1000373449: 
Java Web Start Does Not Work in Some JRE Versions 

Problem 
Java Web Start does not start after you install the L10N package. You will encounter this problem if you use 
JRE 1.4.2_10. 

Solution 

This problem will be fixed in Service Desk 5.10 Patch 3. 

Workaround 

As a workaround, do one of the following: 

Copy the missing jar file to the Java Web Start JRE.  

Select Control Panel → Java → Java → Java Application Runtime Setting.  

Verify that each user JRE runtime has localdata.jar under <JRE_HOME>/lib/ext.  

If the jar file is missing, copy it to that location. 

Define another JRE for the Java Web Start application.  

Select Control Panel → Java → Java → Java Application Runtime Setting.  

Add <OV_INSTALL>/nonOV/jre/1.4/bin/javaw.exe to the user JRE run-time list. 

Set it as the only JRE used (by selecting it and clearing the others). 

General Problems: 
Service Desk 5.10 Patch 1 

This section describes known problems, limitations, and related workarounds in Service Desk 5.10 Patch 1. 

QXCR1000377285: 
Upgrade to Service Desk 5.10 Patch 1 Fails Using Solaris with Microsoft SQL Server 

Problem 
The upgrade to Service Desk 5.10 Patch 1 from the previous Service Desk version stops when using Solaris 9 
or Solaris 10 in combination with Microsoft SQL Server 2000. The upgrade stops during the installation of 
the HPOvObsSv package. 

Solution 
This issue is fixed in Service Desk 5.10 Patch 2. 

Workaround 
As a workaround, follow these steps: 

1 Stop the Service Desk applications installed on any Solaris machine from the command line: 

ovc –stop 

ovc -kill 

2 On a Windows machine, install a primary server with the same Service Desk version as your database. 
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CAUTION: The Install New Primary Server Including Database Upgrade option does not work (see 
QXCR1000382161). 

Installing a new primary server forces you to install a new (temporary) database. 

3 Redirect the Windows primary server to the existing (production) database. 

4 Upgrade the Windows primary server and your (production) database. 

5 Shut down and remove the primary server from the Windows machine.  

Avoid collisions of two primary servers running against one database. 

6 Upgrade the Service Desk applications installed on all Solaris machines. 

QXCR1000382161: 
Upgrade Fails Using the “Install New Primary Server Including Database Upgrade” Option 

Problem 
Upgrading to Service Desk 5.10 Patch 1 fails when using the Install New Primary Server Including 
Database Upgrade option. 

Use Case 

• Have a Service Desk 5.0 Patch 2 database environment available (for example, on Oracle 9.2). 

• Install Service Desk 5.10 Patch 1 management server on a clean Windows environment, select an 
upgrade installation, and direct the installer to the existing database user that needs to be upgraded. 

• While upgrading from Service Desk 5.0 Patch 2 to Service Desk 5.10 Patch 1, the installation and 
upgrade aborts with the following message: 

Component Package installation failed. 

There was a failure with this installation. Component package installation command has 
returned a non-zero error code. HP OpenView Service Desk Management Server will not be 
installed. To rollback this installation and remove all the installed packages, click 
Rollback. To cancel the installation and leave all the packages intact, click Quit. 

Workaround 

Use an environment that does not include the pre-installed old version of Service Desk. Upgrade the 
database immediately after installing a new primary server, rather than upgrading the existing primary 
server. In this case, the problem is present. 

As a workaround, install a previous version of Service Desk first before starting the upgrade installation. No 
error will occur. The primary server and the database will upgrade successfully. 

General Problems: 
Service Desk 5.10 

This section describes how to work around general problems you may encounter with Service Desk 5.10. 



74 

QXCR1000350463, QXCR1000312290, and QXCR1000350190:  
Starting the Management Server on UNIX Platforms  

Problem 

Because of a defect in the GUI Framework component, table views and chart views are not displayed 
properly on a management server running on a UNIX platform. 

If you try to open a view, the following error message is displayed: 

Cannot open this view. This is probably due to a persistence problem with the view. Check 
Object Server log file(s) for more information. 

Workaround 

To overcome this problem, the following workaround must be implemented on the UNIX machine. When the 
management server is started, an X server must be running and used by the ovc process. This can be 
achieved in different ways. One method is described below. 

To make sure an X server is running and used by the ovc process, follow these steps: 

1 Log on to the management server using telnet or another tool. 

2 If the management server software is not stopped, run the following command: 

# /opt/OV/bin/ovc –kill 

3 Start a dummy X server, which is part of most UNIX distributions, including HP-UX and Solaris: 

— HP-UX 

#nohup /usr/bin/X11/Xvfb :9 \ 

0</dev/null \ 

1>/dev/null \ 

2>/dev/null \ 

& 

— Solaris 

#nohup /usr/openwin/bin/Xvfb :9 \ 

0</dev/null \ 

1>/dev/null \ 

2>/dev/null \ 

& 

These commands start the dummy X server on display #9. For more information about this X server, 
refer to http://en.wikipedia.org/wiki/Xvfb or read the man pages.  

4 Before you start the management server again, set the DISPLAY environment variable to point to this X 
server.  

Enter the following commands: 

# DISPLAY=:9 

# export DISPLAY 

# /opt/OV/bin/ovc –start 

http://en.wikipedia.org/wiki/Xvfb
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The views will now be displayed properly. 

If you want to implement this workaround when the server is rebooted, you have to edit the script that 
starts ovc.  

You will find the script in the following location:  

• HP-UX  

/sbin/init.d/OVCtrl 

• Solaris 

/etc/init.d/OVCtrl 

NOTE: You might need to clean the client cache to reload the views from the server.  

To do this, clean out the following folders: 

• UNIX 

$HOME/.ov 

• Windows 

%APPDATA%\HP OpenView 

Incorrect Messages in the Log Files During Installation 

Problem A 

In the system0.0.en_US log file, the following message appears twice consecutively: 

"com.hp.ov.obs.security;SEVERE;441No Passwords in License File error code: 5997" 

Workaround A 

You can safely ignore this message. It does not indicate a severe problem with the software. 

Problem B 

During the installation of Service Desk 5.10 on Solaris, in the system0.0.en_US log file, the following 
message appears: 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdma.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvsdMA.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/OvSdSlm.xml'. 

(ctrl-75) Error deleting registration file '/var/opt/OV/conf/ctrl/ovsdslm.xml'. 

Workaround B 

You can safely ignore this message. It does not indicate a severe problem with the software. 
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Log-on Exceptions 

Problem 

After you install Service Desk, you encounter a log-on exception.  

Workaround 

Before using the Secure Socket Layer logon, execute the OvObsClientSettingsEditor.bat file. 

Failure to execute this file results in the following error message: 

Javax.security.auth.LoginException: Failed to login due to RpcException: unexpected HTTP 

status: 503 Service Unavailable. 

For information about the user authentication mechanisms available, including the use of the Lightweight 
Directory Access Protocol (LDAP) and Active Directory, refer to the Service Desk online help (in the 
Contents tab of the Help Navigator window, select Information for Administrators→Users & Security, and 
then see User  Authentication, Principal Mappings, and Accounts).   

QXCR1000283641: 
Searching for Text from “Localized Text” Does Not Work 

Problem 

By default, it is not possible to search for text in Localized Text or its subfolders.  

NOTE: If you select one of the subfolders of Localized Text, and run Advanced Find, this subfolder becomes 
available to the search engine, and is added as a searchable folder to the bottom of the list in Advanced Find. 
These changes are lost again after restarting the console. 

To reproduce the problem, follow these steps: 

1 Click OV Configuration→Presentation→Localized Text, and select the Localized Text folder. 

2 Open the Advanced Find form by pressing F2 or clicking Advanced Find in the menu bar. 

3 Search for localized text in the Localized Text folder and in one of its subfolders. 

Expected Results 

The Advanced Find form opens. The Show field contains the Localized Text folder. You can select one of its 
subfolders (for example, Label Text). You can run a search in Localized Text and in one of its subfolders. 

Actual Results 

Pressing F2 does not open the Advanced Find form. Clicking the Advanced Find button in the menu bar 
opens Advanced Find, but the Localized Text folder and its subfolders are not available to the search. They 
cannot be selected in the Show field. 

Workaround 

None. 
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Service Pages Installation Stops Responding If Apache and Tomcat are Already Running 

Problem 

When trying to install Service Pages, the installer stops responding and does nothing. To reproduce the 
problem, attempt to install the Service Pages installer. 

Prerequisites 

A system for Service Pages, with the Apache web server and Tomcat Servlet container already running. 

Expected Results 

The installer runs, and the installer splash screen appears.  

Actual Results 

Nothing happens. The installer interface does not appear. 

Workaround 

Stop Apache and Tomcat before running the installer. 

QXCR1000294601: 
Service Level Created from Java Web Start is Not Visible on OvConsole 

Problem 

The service levels created on the Java Web Start console are not visible from OvConsole. 

To reproduce the problem, follow these steps: 

1 Start Java Web Start. 

2 Create one service level. 

3 Start the HP OpenView console. 

4 Open the list of the service levels. 

You cannot see the service level created with the Java Web Start console.  

Workaround 

It is recommended that you reconnect to see other entities. The problem may be fixed after service levels are 
not cached any more. If a client updates a cached entity, other connected clients do not automatically update 
their cache. This design decision was made for performance reasons. Cached entities should be fairly static. 
At the time, the functional impact was considered to be low. 
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QXCR1000242246: 
{I18N} Apache Service is Not Registered in the OS When Installed in a Non-ASCII Path 

Problem 

When a Service Desk installation includes an Apache server (such as the Service Desk 5.10 server 
installation), and is installed in a path that contains non-ASCII characters (for example Chinese, Japanese, 
or Russian), the Apache server is not installed properly.  

As a result, all functionality that relies on the Apache server does not work: 

• Java Web Start client 

• Web UI 

• Service Pages 

• Attachments 

• Online help 

Workaround 

None. 

QXCR1000244548: 
Traces Using Java Web Start 

Problem 

When a client is deployed using Java Web Start, some logs are not recorded. Some of the graphical user 
interface log messages are logged in the Object Server log file. 

Workaround 

None. 

QXCR1000349637: 
Upgrade on Clients Overwrites ovconsole.bat 

Problem 

When you upgrade to Service Desk 5.10, ovconsole.bat is overwritten. Properties, such as Server and 
JAASApplication, are lost. 

Workaround 

Before you upgrade, make a copy of ovconsole.bat (for example, copy the file to ovconsole.old). After 
you upgrade, see the copied file to identify the settings you need, and update ovconsole.bat with those 
settings. 

 



 79 

QXCR1000344669: 
Error When Relation Type is Changed 

Problem 

An error occurs when you attempt to change the relation type of a relation associated with an object (for 
example, if you edit a relation listed on the Relations tab of a service call form, and change the Relation Type 
on the Service Event Relation form). 

Workaround 

Instead of editing the relation, delete the relation, and create it again. 

Service Level Management: 
Service Desk 5.10 

This section describes known problems, limitations, and workarounds related to Service Level Management 
(SLM) in Service Desk 5.10. 

Metric Adapters: Tuning the Query Limitations 

Problem 

The query restriction in the HP OpenView console can be set to display a maximum of 500 metric definitions 
and 1,000 metrics. The query restriction is required to use OVPA metrics or any other metrics with big 
volumes. 

Workaround 

To disable the query restriction, follow these steps:  

1 In the OV Configuration workspace, select Presentation. 

2 In the panel, select Search.  

3 Double-click and select No Restriction (instead of Restricted To) for each of the following objects:  

— Metric Definition  

— OVxx Metric  

— OVxx Metric Definition  
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QXCR1000244984: 
Incidents Generated by the Alarm Engine Are Not Filled Correctly 

Problem 

When an incident is generated by the SLM Alarm Engine, its service-level attribute is not related to the 
generation of the incident. 

Instead, the service-level determination works as follows: 

• If the related configuration item has a service level, that service level is taken. 

• If not, the default service level is used. 

Workaround 

None. 

Java Web Start: 
Service Desk 5.10 

This section describes known problems related to Java Web Start deployment in Service Desk 5.10. 

QXCR1000305148: 
Starting Service Desk 5 Client Deployment Using Java Web Start 

Problem 

If you deploy the Service Desk 5.10 client from a UNIX to a Windows system using Java Web Start, the 
resolution of names must be consistent.  

Workaround 

Make sure that you do not have any inconsistency between the full Internet name and the alias name. For 
example, if you use http://myhostname.domain.org/ovconsole (full Internet name) as a command for 
downloading the Service Desk 5.10 client on Windows, the deployment fails if, on UNIX, the result of 
“hostname” is myhostname (alias name). 

http://myhostname.domain.org/ovconsole
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Usability: 
Service Desk 5.10 

This section describes known usability problems, limitations, and workarounds in Service Desk 5.10. 

QXCR1000290261: 
SQL Server Specific Errors: Cannot Create a Row of Size 14072 

Problem 

When you fill all the fields in a form completely using SQL Server, then try to save the form, you may get an 
error message.  

Workaround 

Remove some information from the form. 

QXCR1000324111: 
In the Web Console, a Service Call SLA and Location Information are Not Retrieved from the 
Adding Caller 

Problem 

In the web console, in some cases a service and an SLA are not retrieved.  

To reproduce the problem, follow these steps: 

1 In the OV Configuration workspace, click System Settings. 

2 Double-click Service and SLA Retrieval Settings for Service Call.  

The Service and SLA Retrieval Settings for Service Call dialog box appears. 

3 In Automatic Service and SLA Retrieval in Service Call, select from the following fields: 

— Caller 

— Caller Organization 

— Service 

4 Add the following search criteria in order:  

— Caller Organization hierarchy 

— Locations of Organization hierarchy 

— Caller 

— Caller’s location 

5 Select Stop the Search if Services and SLAs are Found for a Particular Criterion. 

6 Select Enable Search and SLA Retrieval from Caller Location. 

7 Find the service level impact-priority mappings by clicking Data→Codes→Service Level→Impact 
Priority Configuration. 
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8 Create a new default impact-priority mapping named DIPM (for example, so that a low impact maps to a 
low priority).  

All impacts must be mapped to priorities. 

9 Click Data→Codes→Service Call→Service Call Priority Duration Setting. 

10 Set the priority-duration settings from Top to Low priority: 1 hour, 2 hours, 4 hours, 6 hours, 8 hours, 
and so on.  

11 Click System Settings→General Settings, and then select the Application tab. 

12 Deselect the Search Caller Person in Organization tree. 

13 Using the Default Support Hours field, do the following: 

— Create and relate a support hours schedule named SHDefault, with Sunday 00:00 to 08:00 as 
support hours. 

— Create a support hours schedule named SHA, with Sunday 12:00 to 00:00 as support hours 

— Create a support hours schedule named SHB, with Saturday 12:00 to 00:00 as support hours. 

14 Add a Service Level workspace to a workspace group. 

15 Create a new service level named SLDefault, in which you relate the DIPM impact-priority mapping, 
and select Default. 

16 Create a service level named SL1 related to DIPM. 

17 Create a service level named SLB related to DIPM. 

18 Create two persons, and name them Caller1 and Caller2. 

19 Create an organization named Org. 

20 Make Caller1 and Caller2 members of Org. 

21 Create an organization named POrg, and set the child organization to Org. 

22 Create a business location named LoCaller, and relate persons Caller1 and Caller2 to this location 
(using the Works At field). 

23 Create a business location named LocPOrg, and relate it to POrg (using the Hosted At field). 

24 Create a service named SLocCaller, with the receiver LocCaller. 

25 Create an SLA named SLALocCaller, relate it to SLocCaller, with the receiver LocCaller, and relate 
the service level SLB and support hours SHB (using the Schedules field). 

26 Log on to the web console using the system account. 

27 Create a service call, setting Caller to Caller1. 

Expected Results 

• Service set to SLocCaller, SLA set to SLALocCaller. 

• Caller Location set to LocCaller. 

Actual Results 

• Service is not set. 

• SLA is not set. 

• Caller Location is not set. 

• In the HP OpenView console, everything works as expected. 
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Workaround 

If the caller location is entered in a service call, the service and SLA values are retrieved immediately. 

This error occurs only when the service receiver is a location. If the service receiver is an organization, the 
function works as expected.  

Service Pages: 
Service Desk 5.10 

In Service Pages, when you try to save an item that has no changes to be saved, an exception is thrown. You 
can safely ignore this exception because it does not indicate an error. 

Known Limitations: 
Service Desk 5.10 Patch 16 

There are no known limitations in Service Desk 5.10 Patch 16. 

Known Limitations: 
Service Desk 5.10 Patch 15 

There are no known limitations in Service Desk 5.10 Patch 15. 

Known Limitations: 
Service Desk 5.10 Patch 14 

There are no known limitations in Service Desk 5.10 Patch 14. 

Known Limitations: 
Service Desk 5.10 Patch 13 

There are no known limitations in Service Desk 5.10 Patch 13. 

Known Limitations: 
Service Desk 5.10 Patch 12 

There are no known limitations in Service Desk 5.10 Patch 12. 

Known Limitations: 
Service Desk 5.10 Patch 11 

There are no known limitations in Service Desk 5.10 Patch 11.  
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Known Limitations: 
Service Desk 5.10 Patch 10 

There are no known limitations in Service Desk 5.10 Patch 10.  

Known Limitations: 
Service Desk 5.10 Patch 9 

There are no known limitations in Service Desk 5.10 Patch 9.  

Known Limitations: 
Service Desk 5.10 Patch 8 

There are no known limitations in Service Desk 5.10 Patch 8.  

Known Limitations: 
Service Desk 5.10 Patch 7 

There are no known limitations in Service Desk 5.10 Patch 7.  

Known Limitations: 
Service Desk 5.10 Patch 6 

There are no known limitations in Service Desk 5.10 Patch 6.  

Known Limitations: 
Service Desk 5.10 Patch 5 

There are no known limitations in Service Desk 5.10 Patch 5.  

Known Limitations: 
Service Desk 5.10 Patch 4 

This section describes known limitations of Service Desk 5.10 Patch 4.  

QXCR1000433650: 
Cannot Delete a Template Against the SQL Server 2005 

Problem 

The system displays a pop-up error message when you delete a template against the SQL Server 2005 
database. SQL Server 2005 does not allow more than 253 foreign keys referenced per table. Service Desk 5.1 
uses a table (rep_templates) that owns more than 253 foreign keys. As a result, deleting a template fails.  
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For details, refer to the following web page: 

http://msdn2.microsoft.com/en-us/library/aa933149(SQL.80).aspx 

Solution 

This problem is a limitation of SQL Server 2005. There is no official solution. 

Workaround 

Block the template. 

NOTE: This problem exists since the Service Desk 5.1 major release. 

QXCR1000359570: 
SQL Server Does Not Support ISO Weeks 

Problem 

When defining a graph with a normal client, you can choose an aggregate result over ISO weeks. The process 
works well on an Oracle Database. However, Microsoft SQL Server does not offer a predefined function to 
determine ISO weeks. 

To reproduce this problem, follow these steps: 

1 Make sure that the OBS Server is connecting to a Microsoft SQL Server database. 

2 Start the console. 

3 Select Workspaces→Service Today→Service Call.  

4 Create three new service calls. 

Set the Planned Start to 2005-Jan-01, 2005-Jan-08, and 2005-Jan-15, respectively, for the three 
service calls. 

5 From the menu bar, select View→Current View→Define Views to create a new Chart view.  

6 Select any type as Chart Type. 

In the X-Axis tab, select Planned Start as the Attribute, and Week(52) as the Display format. Save and 
apply the view. 

7 Make sure that the Week of the three new service calls displays in the view as 1, 2, and 3 (that is, in the 
week sequence number of Planned Start). 

8 From the menu bar, select View→Current View→Customize Current View.  

9 Edit the view to set the Display Format to iso Week (53).  

Apply the changed view. 

The Week of the 3 new service calls still displays in the view as 1, 2 and 3.[Expected Result] 

Expected Result 

As the ISO week definitions, 2005-Jan-01 should be week 53. And 2005-Jan-08 and 2005-Jan-15 should be 
week 1 and week 2. These ISO week definitons display correctly on an Oracle Database. 

 

http://msdn2.microsoft.com/en-us/library/aa933149(SQL.80).aspx
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Solution 

N/A 

Workaround 

N/A 

NOTE: It exists since SD5.1 major release. 

Known Limitations: 
Service Desk 5.10 Patch 3  

There are no known limitations in Service Desk 5.10 Patch 3.  

Known Limitations: 
Service Desk 5.10 Patch 2  

This section describes known limitations of Service Desk 5.10 Patch 2.  

Upgrade JDK/JRE to Support 2007 U.S. DST and the Energy Policy Act of 2005 

Problem 

Most time zones in Service Desk work well after the JDK/JRE is upgraded, but the information of some 
other time zones is inconsistent.  

For example, before updating the JDK/JRE, the time zone IET does not use DST, and its name does not 
include the string “DST.” After updating the JDK/JRE, the time zone IET uses DST, but its name still does 
not include the string “DST.”  

As a result, the information shown is inconsistent: 

(UTC-05:00 DST) - (UTC-05:00) - Indiana Eastern Standard Time (Indianapolis) - IET - IET 

Aside from this inconsistency, there are no other time zone issues.  

The following time zones show inconsistent information. 

Search Code Original Name 

IET (UTC-05:00) - Indiana Eastern Standard Time (Indianapolis) - IET 

America/Fort_Wayne (UTC-05:00) - Eastern Standard Time - America/Fort Wayne 

America/Indiana/Indianapolis (UTC-05:00) - Eastern Standard Time - America/Indiana/Indianapolis

America/Indiana/Knox (UTC-05:00) - Eastern Standard Time - America/Indiana/Knox 

America/Indiana/Marengo (UTC-05:00) - Eastern Standard Time - America/Indiana/Marengo 

America/Indiana/Vevay (UTC-05:00) - Eastern Standard Time - America/Indiana/Vevay 

America/Indianapolis (UTC-05:00) - Eastern Standard Time - America/Indianapolis 

America/Knox_IN (UTC-05:00) - Eastern Standard Time - America/Knox_IN 
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Search Code Original Name 

SystemV/EST5 (UTC-05:00) - Eastern Standard Time - SystemV/EST5 

US/East-Indiana (UTC-05:00) - Eastern Standard Time - US/East-Indiana 

US/Indiana-Starke (UTC-05:00) - Eastern Standard Time - US/Indiana-Starke 

America/Araguaina (UTC-03:00 DST) - Brazil Time - America/Araguaina 

Asia/Aqtau (UTC+04:00 DST) - Aqtau Time - Asia/Aqtau 

Asia/Oral (UTC+04:00 DST) - Oral Time - Asia/Oral 

Asia/Aqtobe (UTC+05:00 DST) - Aqtobe Time - Asia/Aqtobe 

Asia/Bishkek (UTC+05:00 DST) - Kirgizstan Time - Asia/Bishkek 

Asia/Almaty (UTC+06:00 DST) - Alma-Ata Time - Asia/Almaty 

Asia/Qyzylorda (UTC+06:00 DST) - Qyzylorda Time - Asia/Qyzylorda 

Asia/Hovd (UTC+07:00) - Hovd Time - Asia/Hovd 

Asia/Ulaanbaatar (UTC+08:00) - Ulaanbaatar Time - Asia/Ulaanbaatar 

Asia/Ulan_Bator (UTC+08:00) - Ulaanbaatar Time - Asia/Ulan_Bator 

Asia/Choibalsan (UTC+09:00) - Choibalsan Time - Asia/Choibalsan 

Workaround 

Adjust the inconsistent time zones from the original names to new names manually, based on the search 
codes below. 

Search Code New Name 

IET (UTC-05:00 DST) - Indiana Eastern Standard Time (Indianapolis) - IET 

America/Fort_Wayne (UTC-05:00 DST) - Eastern Standard Time - America/Fort_Wayne 

America/Indiana/Indianapolis (UTC-05:00 DST) - Eastern Standard Time – America/Indiana/Indianapolis

America/Indiana/Knox (UTC-05:00 DST) - Eastern Standard Time - America/Indiana/Knox 

America/Indiana/Marengo (UTC-05:00 DST) - Eastern Standard Time - America/Indiana/Marengo 

America/Indiana/Vevay (UTC-05:00 DST) - Eastern Standard Time - America/Indiana/Vevay 

America/Indianapolis (UTC-05:00 DST) - Eastern Standard Time - America/Indianapolis 

America/Knox_IN (UTC-05:00 DST) - Eastern Standard Time - America/Knox_IN 

SystemV/EST5 (UTC-05:00 DST) - Eastern Standard Time - SystemV/EST5 

US/East-Indiana (UTC-05:00 DST) - Eastern Standard Time - US/East-Indiana 

US/Indiana-Starke (UTC-05:00 DST) - Eastern Standard Time - US/Indiana-Starke 

America/Araguaina (UTC-03:00) - Brazil Time - America/Araguaina 

Asia/Aqtau (UTC+04:00) - Aqtau Time - Asia/Aqtau 

Asia/Oral (UTC+04:00) - Oral Time - Asia/Oral 

Asia/Aqtobe (UTC+05:00) - Aqtobe Time - Asia/Aqtobe 

Asia/Bishkek (UTC+05:00) - Kirgizstan Time - Asia/Bishkek 

Asia/Almaty (UTC+06:00) - Alma-Ata Time - Asia/Almaty 

Asia/Qyzylorda (UTC+06:00) - Qyzylorda Time - Asia/Qyzylorda 
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Asia/Hovd (UTC+07:00 DST) - Hovd Time - Asia/Hovd 

Asia/Ulaanbaatar (UTC+08:00 DST) - Ulaanbaatar Time - Asia/Ulaanbaatar 

Asia/Ulan_Bator (UTC+08:00 DST) - Ulaanbaatar Time - Asia/Ulan_Bator 

Asia/Choibalsan (UTC+09:00 DST) - Choibalsan Time - Asia/Choibalsan 

Known Limitations: 
Service Desk 5.10 

This section describes known limitations of Service Desk 5.10. 

Schedule Elements 

You cannot include a schedule element in a schedule element. If you want to include a schedule element B in 
a schedule element A, you include (or exclude) the schedule elements in schedule element B. 

Actual Start Field 

Restriction because of defect QXCR1000306550. To prevent reporting problems, you must set the Actual 
Start field to 00:00:00 when you create or update an SLA.  

This change can cause one of two problems: 

• First day is not displayed. 

• Incorrect values are displayed (the values displayed are the values from the previous evaluation period). 

Installer on HP-UX 

The installer on HP-UX does not use the argument -x mount_all_filesystems=false to install the SD-
SLM packages.  

If there are file systems declared in etc/fstab, the installation fails with the following error:  

One or more filesystems that appear in the filesystem table are not mounted and cannot be 
mounted.  

You must modify the file /etc/fstab to be able to install SLM (remove one or more file systems).  

By design, the Software Distributor uses mount_all_filesystems=true as a default value.  Part of the 
reason for this is that file systems may be mounted in the /opt/OV or /var/opt/OV rooted directory 
structure. In addition, the /opt/OV or /var/opt/OV directory structure may contain symbolic links that 
reference other mounted file systems. 

LoadObject Functionality 

Restriction because of defect QXCR1000241122. The LoadObject functionality in Service Desk 5.10 currently 
uses Perl version 5.6. Unfortunately, Perl 5.6 does not support Unicode. As a result, all Service Desk 
functionality that uses LoadObject cannot handle Unicode dataflow properly. This issue impacts all 
integrations that use LoadObject, such as OVO for Windows and OVO for UNIX. 
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Product Co-existence: 
Service Desk 5.10 

This section describes known product co-existence problems, limitations, and workarounds for Service Desk 
5.10. 

Some HP OpenView products share the same component on a specific system. When you install an  
HP OpenView product on a system where another HP OpenView product is already installed, the installer 
first checks to see if the latest version of the shared component is installed. During the install process, an 
older version of a component is replaced with the latest version. In some cases the component process 
scheduled for replacement, as well as other dependent components, are stopped prior to installation. As a 
result, you may need to restart these stopped component processes after installation. For more information 
about restarting these component processes, refer to the relevant product documentation. 

The following examples illustrate the issue. 

OVO for Windows 7.21 and 7.5 

Problem 

When you install the Service Desk 5.10 client on a system where the OVO for Windows 7.21 or 7.5 client is 
already installed, the OVO for Windows HP ITO agent Windows service stops. 

Workaround 

Restart the HP ITO agent manually. 

OVO for UNIX 7.1 

Problem 

When you install the Service Desk 5.10 client on a system where OVO for UNIX 7.1 HP-UX client is already 
installed, the OVO for UNIX llbserver process stops. 

Workaround 

Restart the llbserver process manually. 

OVO for UNIX 8.1 

Problem A 

When you install or uninstall the Service Desk 5.10 client, agent, or OVO for UNIX integration on a system 
where OVO for UNIX 8.1 is already installed, the OVO for UNIX ovcd process and the OVO for UNIX agent 
stop.  

Workaround A 

Restart the ovcd process and the OVO for UNIX agent manually. 
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Problem B 

When you install or uninstall the OVO for UNIX agent on a system where the Service Desk 5.10 
management server is installed, the Service Desk processes stop. 

Workaround B 

Restart the Service Desk processes manually with the command ovc –start. 
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Documentation Errata 
This section describes the following: 

•  Any errors in the published documentation 

•  Latest information that could not be included in the published manuals or online help 

Errors in Online Help 

The following items are listed incorrectly in the documentation and could not be fixed before the software 
release. 

LOCATION: “Enable the detailed List button” online help topic. 

ERROR: Instructions indicate that you should edit the ovconsole [bat, sh] file. This file is 
overwritten when the software is updated or upgraded, so you should not edit it. 

CORRECTION: Do not edit the ovconsole [bat, sh] file. Instead, set the OV_JAVA environment 
variable in the operating system. The executable file that it should point to is java.exe. 
If OV_JAVA points to javaw.exe instead, you will not be able to enable the Detailed List 
button on the memory diagnostic panel. 
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New Content: Ability to Select Certain Email Attachments for Database Rules 

LOCATION: “Configure a Send Email Message Action” online help topic. 

ERROR: You can now send groups of email attachments by using the Send Email Message action 
in a database rule. 

CORRECTION: 

 

Send Email Message Actions 

The Send Email Message action uses the information you provide to send an email 
message to one or more designated recipients. You can include groups of attachments 
that share a specific email classification code. In the following example, all attachments 
classified Red or Blue are included in the email message: 

 

NOTE: You can add a Send Email Message action only to a database rule. You cannot 
add this action to a UI rule. 
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CORRECTION: 
(continued) 

Define Attachment Classification Codes 

Attachment classification codes enable you to group attachments. You can subsequently 
include one or more attachment groups in email messages generated by Database rules. 

The following example shows a console installation with four attachment classification 
codes defined: 

 

You can create, modify, and delete attachment classification codes if your role permits 
you to do so. 
 

To define an Attachment Classification Code:  

1 In the HP OpenView Configuration workspace group, click Data.  

2 In the Data tree, expand the Codes branch. 

3 In the Codes branch, expand General. 

4 In the General branch, click Attachment Classification Code. 

5 If the attachment classification code that you want to work with exists, double-click 
it. If you want to create a new attachment classification code, right-click in the right 
panel, and select New Attachment Classification Code. 

6 In the Text box, type a name for your attachment classification code. 

7 If you want to select an Icon for this code, click the  (find icons) button to select 
one. 

8 If you want to select a Color for this code, click the  (choose color) button to 
select one. 

9 In the Ordering box, enter an integer value that places this code in the proper order 
with respect to any other existing attachment classification codes. 

10 Click File→Save and Close to save your changes. 
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CORRECTION: 
(continued) 

Assign a Classification to an Attachment 

When you attach a file to an object, you can assign an attachment classification to it, as 
shown here: 

 

In this example, there are four attachment classification codes defined: Red, Blue, 
Yellow, and Purple. The classification code that will be assigned to the purple.txt 
attachment is Purple. 

Attachment classifications are used to send groups of attachments to one or more email 
recipients when a database rule triggers a Send Email Message action. If you choose not 
to assign a classification code to an attachment, that attachment will belong to the 
Unclassified group; this is the default. 

You can Define Attachment Classification Codes to suit your environment. Although you 
can change the classification of an attachment at any time, you cannot delete the 
classification altogether. To do this, you must delete the attachment and then create it 
again. 
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CORRECTION: 
(continued) 

To assign a classification to an attachment: 

1 Open a form for an object. 

If the attachment that you want to classify is already attached to this object, go to 
step 5. 

2 Click the  (attachment) button on the toolbar. 

If the toolbar is not visible, click View→Toolbars, and select Standard. 

3 Browse for the file, and click Open. 

4 Click the Attachment Details tab. 

5 Right-click the attachment, and select Attachment Classification. 

6 Select a classification code for the attachment. 

7 Click File→Save and Close. 

 

Configure a Send Email Message Action 

Use this action to have a database rule send an email message to one or more recipients. 
You can attach one or more groups of files (attachments) to this email message. 

To configure a Send Email Message Action, complete the following steps: 

1 Open a Send Email Message Action form from the Database rules wizard. 

If you are not in the process of creating a Database Rule, see the help topic titled 
“Creating Database Rules and UI Rules.” 

2 Type a name for the action in the Name field. 

3 Select the Blocked box if you want to disable this action. 

4 In the Send To field, enter one or more addresses to which the email message should 
be sent. Use the Insert Attribute button to enter predefined email addresses. 

NOTE: If you specify multiple email addresses, separate them with a semicolon (;) 

5 In the Subject field, enter the text you want to appear in the subject line of the 
email. Use the Insert Attribute button to insert predefined pieces of information, 
such as a priority or a deadline for response.  

6 In the Message field, compose the text of the email message you want the action to 
send. You can use the Insert Attribute button to insert predefined pieces of 
information. 

7 Optional: If you want to include one or more groups of attachments in the email 
message, select the groups that you want in the Classifications box. 

If the only classification listed in the box is Unclassified, that means that no 
attachment classifications have yet been defined.  

8 When you have configured the Action, click OK. The new action now displays as an 
available action for the rule. 
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New Content: Reusable custom codes, UI rule actions that limit value ranges for fields, and a generic 
association mechanism. 

LOCATION: “Limit Field Value Range by Relations Actions” online help topic. 

“Configure a Limit Field Value Range by Relations Action” online help topic. 

ERROR: This content is not included in the Service Desk 5.10 online help. The online help topics 
listed above are incomplete and incorrect. 

CORRECTION: 
Limit Field Value Range by Relations Actions 

This type of action determines which values for a code type attribute appear in the drop-
down list representing that attribute on forms. These values are not stated explicitly but 
instead depend on the values of one or more other code type attributes. 

In the following form, for example, the Assignment Priority choices for the Sample 
Incident have not been limited in any way: 

 

All four of the Assignment Priority code values are available in this form. 



 97 

 

CORRECTION: 
(continued) 

In this example, however, the values available for the Assignment Priority code are 
limited to Low and Medium: 

 

This constraint of the Assignment Priority code values was the result of a Limit Value 
Range by Relations action that was triggered by a UI rule. 

There are three steps required to successfully invoke this type of action:  

1 Create a relationship between two codes. 

2 Create a value reference mapping that defines how the value of one code should vary 
with the value of the other. 

3 Define a UI rule that enforces the value mapping. To do this, you must configure a 
limit field value range by relations action for this rule. 

Here is a simple example of how this process works. In this example, the values of the 
Assignment Priority code for an Incident are based on the value of the Severity code for 
that Incident. 
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CORRECTION: 
(continued) 

Step 1: 

Create a relationship between the Severity code and the Assignment Priority code. 
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CORRECTION: 
(continued) 

Step 2: 

Create one or more value reference mappings to define how the values of the target code 
should vary with value of the input code. 
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CORRECTION: 
(continued) 

Step 3: 

Define a UI rule that invokes an action that enforces the mapping. 
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CORRECTION: 
(continued) 

In this example, the database rule limits the value of the Assignment Priority code for 
an Incident whenever the Severity code for that Incident changes. Here is the result for 
an Incident where Severity is Minor: 

 

In addition to built-in codes, you can use custom codes to create a Limit Field Value 
Range by Relations action in a UI rule. See an advanced example for more information 
about using custom codes. 

NOTE: A UI rule can trigger a Limit Field Value Range by Relations action in the 
background as a result of another rule. If this happens, subsequent Update Data actions 
linked to other rules can only set a value allowed by the most recent Limit Field Value 
Range by Relations action. 

An Advanced Example  

NOTE: The explanations and examples shown here only limit the values of code 
attributes. While it is most common to do this with codes, technically any reference 
attribute can be limited in this fashion.   

This example features a UI rule that uses the Limit Field Value Range by Relations 
action with custom codes. In this example, a hypothetical company has support offices in 
two regions: 

• Asia / Pacific 

• Europe / Americas 

Lower severity Incidents (Severity = Normal, Warning, or Minor) are routed first to the 
Asia / Pacific support office; higher severity Incidents (Severity = Major or Critical) are 
routed to the Europe / Americas office.  

NOTE: This is a highly contrived example designed to highlight the functionality of this 
action. The HP OpenView console offers much simpler ways to route Incidents to the 
proper offices. 



102 

CORRECTION: 
(continued) A UI rule will be configured to limit the values available for the State field (Incident 

Status code) whenever an Incident is assigned to a new support agent. The rule will use 
a Limit Field Value Range by Relations action that traverses the following chain of 
relationships: 

 

In this example, Severity and Incident Status are built-in codes. Support Agent Types 
and Support Regions are custom codes. 

Three Incident State values were added to indicate that an Incident has been assigned to 
a particular support region: 
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CORRECTION: 
(continued) 

Before the rule is applied, the Incident State choices for the Sample Incident have not 
been limited in any way: 

 
 

Note that this Incident has not been assigned to a Person yet, and all seven of the 
Incident Status code values are available in this form. 
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CORRECTION: 
(continued) 

After the UI rule fires, however, the values available for the Incident State code are 
limited depending on the Severity of the Incident. In this case, only one State choice is 
available after the Incident has been assigned to Klara Hausmann: 

 
 

This has nothing to do with Klara Hausmann’s location. The constraint of the values 
available for State results from the Severity of the Incident. 

Here are the steps necessary to create this example: 

Create the custom codes. 

Create forms for each of the custom codes. 

Create the relations in the chain. 

For each of the codes in the chain, create value reference mappings. 

Create a UI rule that triggers when the To Person field changes. 

Create the Limit Value Range by Relations action. 

Each of these steps is shown here with screen captures. 
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CORRECTION: 
(continued) 

Step 1: Create the custom codes Support Agent Types and Support Regions, and create 
values for both codes: 
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CORRECTION: 
(continued) 

Step 2: Create a form for each of the new custom codes: 
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CORRECTION: 
(continued) 

Step 3: Create the following relationships: 
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CORRECTION: 
(continued) 

Step 4: Define a UI rule that invokes an action that enforces all the mappings: 
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CORRECTION: 
(continued) 

Step 5: Create a UI rule that triggers when an Incident is assigned to a Person.  

Here is the result for an Incident where Severity is Minor: 

 

Here is the result for an Incident where Severity is Major: 
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CORRECTION: 
(continued) 

Use Custom Codes  

In addition to the built-in code type attributes that came with your HP OpenView 
application, you can create custom codes. These are useful when you want to create  
m-to-n relationships between objects that are not otherwise related to each other. The 
primary purpose of such relationships is to construct Limit Field Value Range by 
Relations Actions for UI rules. 

After you create a custom code, you can use it like any other code in the console. You 
must, however, first create a new form for your custom code before you can use it to 
construct an action for a UI rule. 

To create a custom code: 

1 In the HP OpenView Configuration workspace group, click Data. 

2 In the Data tree, expand the Codes branch. 

3 In the Codes branch, click Custom Codes. 

4 Right-click your mouse in the right panel, and select New custom code (ordered). 

5 In the Name box, type a name for your custom code. 

6 In the Key box, type a short string of characters that has not previously been used as 
a Key for another custom code. 

7 From the Module list, select the module where you want to store your custom code. 

8 Click OK to save your custom code.  

9 In the Presentation workspace of the HP OpenView Configuration workspace group, 
create a new form for your custom code. Be sure to include the Referenced From 
field on your form. 

Create a Relationship Between Two Codes  

Before you can create a Limit Field Value Range by Relations action for a UI rule, you 
must create a relationship between two codes. This is a mechanism you can use to create 
m-to-n relationships between objects. 

To create a relationship between two codes: 

1 In the HP OpenView Configuration workspace group, click Data. 

2 In the Data tree, click Relations. 

3 Right-click your mouse in the right panel, and select New Relation. 

4 In the Text box, type a name for your new relationship. 

5 In the From box, select the code that you want the relationship to originate from.  

6 In the To box, select the code where you want the relationship to terminate. 

7 Optional: In the Comment box, type a descriptive comment. 

8 Click File→Save and Close to save your new relationship. 
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CORRECTION: 
(continued) 

Create a Value Reference Mapping  

Before you can create a Limit Field Value Range by Relations action for a UI rule, you 
must create a mapping from each possible value for one code to one or more values for 
the other code. See Limit Field Value Range by Relations Actions for an example. 

To create a value reference mapping: 

1 In the HP OpenView Configuration workspace group, click Data. 

2 In the Data tree, expand the Codes branch. 

3 Double-click the specific code type that terminates the relationship. 

For example if you have created a relationship from A to B, double-click B. 

    

4 For each code B value that you want to map, follow these steps: 

a. In the right pane, double-click a code B value. 
 

A form specific to code B opens. If you created a custom code, this will be the 
form that you created. 

 
b. For each code A value that you want to map to this code B value, follow these 

steps: 
 

i. In the Referenced From field, click New. 
 

The New--- Reference dialog box opens. 
 
ii. In the Relation field, use the quick find function to select the relationship 

that you created for your two codes. 
 
iii. In the From field, use the quick find function to select the code A value 

that you want to map. 
 

The description for the code A value appears in the From Description box. 
This is a read-only field. The description for the code B value that you 
double-clicked in step (a) appears in the To Description box. This is also a 
read-only field. 

 
iv. Click OK to save your changes and close the New– Reference dialog box. 

5 Click File→Save As to save your mappings for this code B value. 

Return to step 4(a) if you want to map additional code B values. After you have mapped 
all the values that you want to map, you can create Limit Field Value Range by 
Relations Actions for UI rules based on this relationship. 



112 

 

CORRECTION: 
(continued) 

Configure a Limit Field Value Range by Relations Action  

After you create a relationship between two codes, and you create a value reference 
mapping between them, you can use this relationship to create a Limit Field Value 
Range by Relations action in a UI rule. 

For this procedure, assume again that you have created a relationship from code A to 
code B and that you want to use this relationship to limit code B’s values by using a UI 
rule: 

 

To configure a Limit Field Value Range by Relations Action, complete the following 
steps: 

1 In the UI rules wizard, select the Limit field value range by relations action. 

2 If you are not in the process of creating a UI Rule, see the online help topic titled, 
“Creating Database Rules and UI Rules.” 

3 In the Name box, type a name for the Action that you are creating. 

4 Optional: Select the Blocked box if you want to disable this Action.  

5 In the Target Field box, select code B, whose values you want to limit. 

6 In the Input Field box, select code A. 

7 In the Relationship Type 1 box, select the relationship you defined between code A 
and code B. 

It is possible to create a chain of up to four relationships between codes. In this case, 
you would select additional Relationship Type fields to traverse this chain. 

8 Click the Add to List button. 

You have just created a pattern that will limit the values for code B based on the 
value of code A when the UI rule trigger condition occurs. You can create a number 
of patterns if you want to. The patterns are tested in the order they are listed until a 
pattern returns a set of values. 

If you want to create more patterns, repeat steps 5-7. 

9 When you have finished configuring the action, click OK. The new action now 
displays as an available action for the UI rule. 

10 Click Next to continue creating the UI rule. 

11 In the Name box, type a name for your new rule. 

12 Optional: Select a Category for the rule. 

13 Optional: Select Block if you want to prevent this rule from firing. 

14 Optional: Select Debug if you want the console to print debug information to the rule 
log file. 

15 Click Finish to save your new UI rule. 
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New Content: Audit Configuration Information 

LOCATION: “Audit Configuration Information” online help topic. 

ERROR: You can now audit information in the HP OpenView Configuration workspaces. 

CORRECTION: Audit Configuration Information 

In addition to auditing objects in the database, you can configure the console to audit 
changes that occur in the following HP OpenView Configuration workspaces: 

• Actions & Rules 

• Data 

• Presentation 

• System Settings 

• Templates 

• Users & Security 

You can also configure the console to audit object deletions and history line deletions. 

This enhanced audit information is stored in the HP OpenView database. Here is an 
example of a list of audit entries: 

 

To manage the amount of audit data in the database, you can archive audit entries that 
have reached a certain age. 

NOTE: To view the enhanced audit log or modify the configuration audit settings, you 
must log on to the console by using an account that includes the Auditor role. The built-
in System Administrator account does not include the Auditor role. 
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CORRECTION: 
(continued) 

View the Enhanced Audit Log 

You can view a list of all the configuration audit entries that have accrued since the last 
audit archive operation was performed. Current audit entries are stored in the HP 
OpenView database. 

To view the enhanced audit log: 

1 Log on to the console by using an account that includes the Auditor role and has 
permission to view the enhanced audit log. 

2 In the HP OpenView Configuration workspace group, click Users & Security. 

3 Expand the Audit branch. 

4 Expand Enhanced Auditing. 

5 Click Audit Log. 

 

The enhanced audit log entries appear in the right pane. 
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CORRECTION: 
(continued) 

Modify the Configuration Audit Settings 

If you are a console auditor, you can instruct the console to create audit entries each 
time specific items in the HP OpenView Configuration workspace group change. You can 
also enable auditing for object deletions and history line deletions. 

NOTE: To modify the configuration audit settings, you must log on to the console by 
using an account that has the Auditor role. The built-in System Administrator account 
does not include the Auditor role. 

To modify the configuration audit settings: 

1 Log on to the console by using an account that includes the Auditor role and has 
permission to configure enhanced audit settings. 

2 In the HP OpenView Configuration workspace group, click System Settings. 

3 Double-click the Audit Configuration icon. 

4 In the Audit Configuration dialog box, click the Audit Configuration tab. 

5 If you want to audit changes that take place in any of the HP OpenView 
Configuration workspaces, follow these steps:  

a. Select Enable Enhanced Auditing. 
 

b. In the workspace tree on this tab, select all the things you want to audit: 

 

⎯ You can select whole branches of the tree or individual items within each 
branch. 

6 If you want the console to create an audit entry whenever an object is deleted from 
the database, select Audit Item Deletions. 
 
An audit entry will only be created if one or more attributes of this object type are 
already being audited. See the online help topic titled “Configure Audit Rules” for 
more information about auditing objects. 

7 If you want the console to create an audit entry whenever a history line is deleted, 
select Audit History Line Deletions. 

8 Click OK. 

9 Log off the console. 
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CORRECTION: 
(continued) 

Archive Audit Information 

If you are a console auditor, you can initiate an archive process to move old audit entries 
to an archive file. This controls the size of the audit information in the database. You can 
specify the location of both the archive file and the log file for the archive process. You 
can also specify the age at which audit file entries should be archived. 

To archive audit information: 

NOTE: To modify the configuration audit settings, you must log on to the console by 
using an account that has the Auditor role. The built-in System Administrator account 
does not include the Auditor role. 

1 Log on to the console by using an account that includes the Auditor role and has 
permission to configure enhanced audit settings. 

2 In the HP OpenView Configuration workspace group, click System Settings. 

3 Double-click the Audit Configuration icon. 

4 In the Audit Configuration dialog box, click the Archive Configuration tab. 

5 In the Archive file box, type or browse to the folder (directory) where you want the 
console to store the archive of audit entries. 

6 In the Log file box, type or browse to the folder (directory) where you want the 
console to keep the log file for the archive process. 

7 In the Days box, enter the age in days after which an audit entry should be archived. 

8 Click Start to initiate the archive process. The progress bar indicates what fraction of 
the process is completed. 

9 When the archive process is finished, click View Archive to see the contents of the 
archive file; click View Log to see the details about the archive process. 
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HP OpenView Performance Insight 

To use HP OpenView Performance Insight with Service Desk 5.10, you need to purchase the following 
components: 

• HP OpenView Performance Insight 5.1 

• HP OpenView Performance Insight Database Connector (one for each Service Desk server from which 
you want to report) 

• Your choice of the following: 

— HP OpenView Performance Insight Report Pack for Helpdesk Manager 

— HP OpenView Performance Insight Report Pack for Change Manager 

— HP OpenView Performance Insight Report Pack for Service Level Manager 

Media and Manuals for HP OpenView Performance Insight are purchased separately.  The manuals are 
available in PDF format on the CDs. 

There is a starter bundle, HP OpenView Performance Insight Starter Bundle for Service Desk 5.10. The 
starter bundle includes HP OpenView Performance Insight 5.1, HP OpenView Performance Insight 
Database Connector, and the HP OpenView Performance Insight Report Pack for Helpdesk Manager. 

Prerequisites 

Database 

OVPI 5.1 supports only Oracle 9.2.0.5 with the “partitioning feature” configured. 

NOTE: Windows XP is not supported. 
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Accessibility Support 
HP is working to ensure that new HP OpenView management software releases comply with the latest 
international accessibility standards.  HP OpenView Service Desk 5.10 accessibility includes an improved 
user interface interaction model that allows screen readers to support users with visual impairments, and 
enhanced keyboard navigation as an alternative to mouse control.   

Product characteristics based on accessibility standards include:  

• No animations in the user interface 

• No requirement for user speech 

• Operability within a limited reach and strength 

• No requirements for simultaneous actions except as provided by the operating system 

• Consistent meanings of images  

• No flashing at a frequency where photosensitive epilepsy is a risk 

• Redundant coding of all audio signals as provided by the operating system 

• No requirements for timed responses 

• Consistent and well-defined focus and selection indicators 

• Alternative text for images 

• Redundant coding for use of color 

• Online help optimized for screen readers 

HP OpenView Service Desk 5.10 supports accessibility on Microsoft Windows operating systems using JAWS 
for Windows 4.5.  For a more detailed report of product compliance with Section 508 of the American 
Rehabilitation Act, go to the Check Product Accessibility web page at:. 

http://vgwh3pro.cce.hp.com/508/ 

1 From the Select Product Category list, select Software and Operating Systems, and then click Go. 

2 On the next screen, select HP OpenView Service Desk from the Product Family list, and then click Go. 

You can request accessible electronic manuals for this product by visiting the HP OpenView Product 
Manuals web site at: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 Click Send Feedback near the bottom of the page. 

2 Specify the product name, product version, operating system, and document names, and indicate that 
you would like to obtain them in fully accessible form. 

 

http://vgwh3pro.cce.hp.com/508/
http://ovweb.external.hp.com/lpe/doc_serv/
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Configuring HP OpenView Service Desk 5.10 Accessibility 

To activate accessibility support, perform the following: 

1 After product installation, look in the following directory:  

%INSTALLDIR%\nonOV\jre\b\lib\ext  

On Windows, the default INSTALLDIR is the following: 

C:\Program Files\HP OpenView 

Make sure the following Sun Java 2 platform edition 1.4.x files are located in the directory: 

— jaccess-1_4.jar 

— access-bridge.jar 

If the files are not in the correct directory, download the Access Bridge 2.0.1 Manual Install (.zip) from 
the following website: 

http://java.sun.com/javase/technologies/accessibility/accessbridge/ 

After downloading, unpack the file to the following directory: 

%INSTALLDIR%\nonOV\jre\b\AccessBridge\ 

Copy the two jar files (listed above) from the following directory: 

%INSTALLDIR%\nonOV\jre\b\AccessBridge\installerFiles\ 

2 Add the AccessBridge directory to your path: 

PATH=%INSTALLDIR%\nonOV\jre\b\AccessBridge\installerFiles\;%PATH%  

This step ensures that the DLLs are part of the Java Access Bridge, and can be found and instantiated. 

3 Make sure the accessibility.properties file is located in the following directory: 

%INSTALLDIR%\nonOV\jre\b\lib directory.   

If needed, you can copy the file from the following directory: 

%INSTALLDIR%\nonOV\jre\b\AccessBridge\installerFiles 

The Java Virtual Machine (JVM) reads a number of property files as it starts up.   

4 Use each line in the accessibility properties file to enable different accessibility features.   

For example, to enable assistive technologies to use the Java Access Bridge, use a file editor to include 
the following line in the file: 

assistive_technologies=com.sun.java.accessibility.AccessBridge  

For additional properties examples and explanations (for example, how to set up screen magnifiers), 
refer to the Java Accessibility Utilities documentation: 

http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html 

For more about configuring accessibility with Sun Java applications, refer to the following web site: 

http://java.sun.com/products/accessbridge/docs/setup.html. 

http://java.sun.com/javase/technologies/accessibility/accessbridge/
http://java.sun.com/products/jfc/jaccess-1.2/doc/examples.html
http://java.sun.com/products/accessbridge/docs/setup.html
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Integration with Other HP OpenView Solutions 
For information about the integration with HP OpenView Operations, refer to the HP OpenView Service 
Desk Operations Integration Administrator’s Guide. For information about the other integrations, refer to 
the HP OpenView Service Desk Data Exchange Administrator’s Guide. These guides are released with the 
integration release of which they form a part. They are not delivered in Service Desk 5.10. 

 

Troubleshooting 
This section describes how to troubleshoot some problems in Service Desk. 

Installation Fails 

Problem 

The installation fails. 

Workaround 

If you installed the management server, examine the server_<build number>_HPOvInstaller.txt log 
file, located in the %TEMP%\HPOvInstaller\ folder. 

The component log files are located in %TEMP% in the HPOvInstaller directory. The paths and file names 
are as follows:  

• Windows 

%TEMP%\HPOvInstaller\server_<build number>, where <build number> is the version and build 
number (for example, 5.10.742) 

package_msi_<component>_install.log, where <component> is the name of the component 

• UNIX 

/var/tmp/HPOvInstaller/server_<build number>, where <build number> is the version and 
build number (for example, 5.10.742) 

package_depot_<component>_install.log, where <component> is the name of the component. 

These log files hold information about the native installation of the component. On a Windows platform, 
search in the log file for the words “Return Value 3”, which usually indicates there was an error. 

On HP-UX, examine the swagent.log file located in /var/adm/sw/swagent.log.  

Examine the Object Server log file for information about why the installation failed. 

The Object Server log file is located in the following directory: 

%OVDATADIR%/log/system0.0_enUS 

This file contains the information from the Object Server and its tools. Look at the bottom of the file for any 
exception or other error message that might explain the failure. 
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XPL Logging 

Problem 

You would like to change the way information is logged. 

Solution 

XPL logging uses the default Java logging.properties file. 

By default, this file is located in the following directory: 

C:\Program Files\HP OpenView\nonOV\jre\1.4\lib\logging.properties.  

For this file to work, you must execute the following once:  

ovconfchg -ns xpl.log -set logparent true 

For example, if you want all the logs to be written to the console, add the following lines to your 
logging.properties file:  

handlers=java.util.logging.ConsoleHandler 

java.util.logging.ConsoleHandler.level=INFO 

java.util.logging.ConsoleHandler.formatter=java.util.logging.SimpleFormatter 

In the logging.properties file, you can specify the logging level: 

• SEVERE 

• WARNING 

• INFO 

• CONFIG 

• FINE 

• FINER 

• FINEST 

Example: 

To specify finer logging for the Object Server, add the following to your logging.properties file: 

java.util.logging.ConsoleHandler.level=FINER 

com.hp.ov.obs.level=FINER 

Object Server Cache 

Problem 

The Object Server cache can cause problems.  



122 

Solution 

If you encounter a problem when you start the Object Server using ovc –start, try to delete the Object 
Server cache files by deleting all of the files in the following folder:  

C:\Program Files\HP OpenView\data\datafiles\obs 

Control Service Pid Files 

Problem 

You are unable to start the control service. 

Solution 

Execute the following command: 

• Windows 

del C:\Program Files\HP OpenView\data\tmp\*.* 

• UNIX 

rm –f /var/opt/OV/tmp/* 

Console Does Not Show Any Workspaces 

Problem 

Your console screen does not display any workspaces. 

Solution 

Clear your user settings by executing the following command: 

del C:\Documents and Settings\%USERNAME%\Application Data\HP OpenView\*.* /s /q 

Socket Time Out 

Problem 

In some cases, the default value for the Socket Time Out management server setting is too low. This problem 
has been noted on the Sun Solaris operating system. 

If the following message appears in the system0.0.en_US log file, it might indicate that this setting should 
be increased: 

com.hp.ov.obs;SEVERE;Error: Interrupted due to: Read timed out. 

Solution 

Increase the value of Socket Time Out. Set a value of 5000ms (1000ms is the default). 

For more information about how to change Socket Time Out, refer to the HP OpenView Service Desk 
Administrator’s Guide. 
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Support 
You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html 

http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Legal Notices 
© Copyright 2005-2011 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor’s standard 
commercial license. 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.  

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on 
all HP 9000 computers are Open Group UNIX 95 branded products. 

Java™ is a US trademark of Sun Microsystems, Inc. 

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

OpenView® is a registered U.S. trademark of Hewlett-Packard Company. 

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group. 
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